Previous features and fixed issues

This build includes many fixed issues, including the following updates from previous releases.

12.2 New Features

® SQL Diagnostic Manager offers a brand-new browser interface framework, called SQLDM Web Console, offering:
© Highly responsive user experience.
Light Mode and Dark Mode options.
Context-Aware Interface for Mobile and Tablet support.
Simplified single-product focus built on a common design but not sharing on a single product.
Flexible design to easily update third-party components.
Consolidated interface gathering together SQLDM Mobile, SQLDM IDERA Dashboard, and Windows Client.
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IDERA Dasboard support

The prior browser interface for SQL Diagnostic Manager in IDERA Dashboard will continue to be supported in addition to the new
SQLDM browser interface. However, it is no longer part of the SQL Diagnostic Manager installation or the preferred browser interface
for SQL Diagnostic Manager. If you wish to continue using IDERA Dashboard, you can install it separately and manually register SQL
Diagnostic Manager.

12.2 Fixed Issues

Reports
The Top Servers by Percent Usage report correctly displays CPU SQL Usage (Percent) values.
SQL Diagnostic Manager now successfully exports the Plan XML (Estimated) report from the Event Occurrences detail view.

The Server Uptime report pops up a "Select SQL Server" message when you do not select a server, otherwise, it works as
expected.

SQL Diagnostic Manager correctly gathers, stores, and reports Database Statistics.

SQL Diagnostic Manager 12.2 correctly generates the Enterprise Summary reports including the SQL Server version of your
instances.

The Database Growth Forecast report is correctly generated.

The Disk Space History report correctly lists the disk available on the monitored instances.
The Disk Space History report is correctly generated for seven, 15, and 30 days.

The Transaction Log statistics successfully return historical data.

Alerts

SQLDM-31924 SQL Diagnostic Manager 12.2 correctly triggers email notifications for Database Full (Percent) and Filegroup Full Space
(Percent) alerts.

SQL Diagnostic Manager 12.2 successfully triggers email notifications for Log Full (Percent) alerts.

The Blocked Sessions alert is successfully triggered in the configured response alert time.
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SQL Diagnostic Manager successfully triggers the Unsubscribed Transactions (Seconds) alert once is configured and
enabled.

The CPU Statistics report correctly shows trends for CPU usage, displaying the correct values for the
CPUActivityPercentange alert.

SQL Diagnostic Manager allows you to clear the recommendation alerts from the Alert Recommendation window until it raises
again.

SQL Diagnostic Manager allows you to snooze operational alerts but not clear them from recommendations.

The Alert Configuration timeout value has been changed to get better performance.

SQL Diagnostic Manager now correctly generates Blocking alerts and reports.

SQL Diagnostic Manager correctly excludes databases from the Days Since Last Backup metric when exclusions are defined.
SQL Diagnostic Manager correctly monitors the status of the DTC service.

SQL Diagnostic Manager dismisses Availability Group Role Change alerts correctly.

General
SQL Diagnostic Manager no longer generates the "Unhandled exception: SplitterDistance must be between Panel1lMinSize

and Width - Panel2MinSize" when using the desktop client under certain screen resolutions.

DM Console

Users can now successfully add an existing user from one cluster to another while maintaining the original security settings.
SQL Diagnostic Manager allows you to correctly check the licensed SQL Server instances in the Manage Servers window.
SQL Diagnostic Manager console works as expected with more than 100 servers registered.

SQL Diagnostic Manager can now successfully enable/disable Maintenance modes using Tags.

The Tags view displays data with more than 100 created tags.

The Add Server Wizard now saves the Query Monitor settings when the SQL Server instance is added.

SQLDM-31819 SQL Diagnostic Manager 12.2 successfully connects to monitored SQL servers after the KB5004442 Microsoft patch has
been applied.

The SQL Diagnostic Manager Management Service no longer crashes when there are more than one SNMP action provider
configured.

SQL Diagnostic Manager 12.2 response time has been improved.

SQL Diagnostic Manager's recommendation engine has been updated to include additional recommendations found in SQL
Doctor.

The SQL Diagnostic Manager repository database now supports 2012 and higher compatibility levels.

SQL Diagnostic Manager correctly displays the session status of ROLLBACK after a session is killed.

Disks

SQL Diagnostic Manager now successfully displays Disk Activity information for cluster shared volume drives (CSVFS)
databases.

Table



SQL Diagnostic Manager correctly populates the list of mount points on the monitored instances.

Analysis

You can now successfully perform the Analysis Status of Azure instances.

Services

SQL Diagnostic Manager services perform successfully, making it possible that the Aggregation and Grooming jobs to work
as expected.

High Availability Groups
The Long Send Rate (KB/s) metric now works as expected in High Availability Groups.

The Availability Group History browser successfully displays the replica role status on particular instances.

Upgrade

The user can successfully add a new user after upgrading SQL Diagnostic Manager.

DBaaS

SQL Diagnostic Manager no longer generates sys.availability_group_listeners errors when monitoring Azure SQL Databases.

Forecast alerts are successfully generated for Azure Manage Instance and Azure SQL Databases.

Metrics
SQL Diagnostic Manager correctly reports the correct values for the SQL Server Usage (Percent) metric.
SQL Memory Usage metric correctly calculates the percentage of the total memory used by Azure SQL servers.

SQL Server Agent Long Running Job (Percent) metric now provides the correct value.

Queries
SQL Diagnostic Manager correctly associates query data to the correct monitored instance.

SQL Diagnostic Manager successfully gathers query data through Query Monitor on instances containing databases that
have a trailing space in the database name.

SQL Diagnostic Manager allows you to successfully refresh your data in any Query View.
Users can now successfully configure the Query monitoring on any environment.

SQL Diagnostic Manager successfully provides Query Plans. You can fetch them by clicking on the green icons of the Detail
column of the Event Occurrences table.

History Browser

History Browser successfully changes the custom settings when moved to other servers.

This build includes many fixed issues, including the following updates from previous releases.



12.0 New Features

® SQL Diagnostic Manager performs Scale-out Architecture, including the following features:

© Multiple DM Installations in a single DM Console

© Targeting +2000 instances over four DM Installations

© Full Administrative support for DMSO Cluster Environments
® Connectivity and workability across untrusted domains using an Alternative Windows Collection Account.
® Support upgrades from existing Installations.

12.0 Fixed Issues

Reports
When the Deadlock report is generated, SQL Diagnostic Manager sends the email with the correct data.

SQL Diagnostic Manager added a synchronization state column to the Availability Group Topology report.

The Deadlock report includes all the collected data.
Custom Counters reports are now exported successfully.
The Availability Group Statistics report works as expected. The report is generated within the expected time.

The Deadlock report lists all the deadlocks and no deadlock is repeated.

The Add Custom report wizard's Ul works as expected.

SQL Diagnostic Manager now successfully collects data for the Database Growth Forecast report.

In the Overview Dashboard, the Lock Waits report correctly displays data for all the instances.

Alerts

Database Full (Percent) alert is woking as expected, it is not displaying false data.

SQL Diagnostic Manager now successfully saves the Where metric severity has changed condition when it is checked or
unchecked.

SQL Diagnostic Manager correctly monitors the servers and SQLDM Management service memory consumption is as
expected.

SQL Diagnostic Manager now correctly generates the OS Privileged CPU and User CPU Usage alerts.

The Filegroup Space Full (percent) and Log Full (percent) alerts are working as expected when the database is set to 'no
autogrowth' and the alerts configuration is set to 'Yes, alert con the currently used size divided by the maximum possible size'.

The Blocking Session Wait Time (seconds) alert is working as expected. The date and time displayed are equal to the
deadlock creation time.

The All Servers Thumbnail view works as expected when a server alert triggers a status change.

SQL Diagnostic Manager now takes primary nodes instances to generate the Days since last backup alert, avoiding false
alerts.

The Session CPU Time(seconds) alert raises for on-premise instances.

When a job exceeds the time limit, the SQL Server Agent Long Running Job (Percent) alert raises. If the job is stopped,
completed, or canceled the alert is deactivated.



The Filegroup Space Full (percent) and the Log full (percent) alerts work as expected.
Days since last backup alert works as expected on secondary replicas (AlwaysOn) instances.

SQLDM-31537 The Availability Group Estimated Data Loss (Seconds) triggers a critical alert after the Suppression Time alert and a warning
alert before the Suppression time alert.

SQL Diagnostic Manager gets Baseline alerts successfully.

SQL Diagnostic Manager successfully notifies alerts for failed SQL Jobs by sending an email.
SQL Diagnostic Manager 11.1.6 now triggers the correct Days since last backup alerts.

The File Group Space Full (Percentage) alert correctly reports within the expected parameters.

SQL Diagnostic Manager now correctly triggers the Days since last backup alert for secondary replicas.

General

SQL Diagnostic Manager now correctly detects the drives with WMI and OLE automation for added local instances.
Desktop Console view keeps custom views changes after adding servers.

SQL DM Repository does not use Deprecated Data Types anymore when SQL Server 2019 hosts it.

SQL Diagnostic Manager successfully refreshes data of the selected server, keeping the original server name.
SQL Diagnostic Manager allows selecting more than one-month of data across servers.

SQLDM-31103 Users' permissions are now working as expected. Users with view access permissions cannot access all options in SQL
Diagnostic Manager

The History Browser Range is properly populated according to the selected time range.
When adding a new server, the Advanced Encryption Options section shows the correct options to encrypt connections.
SQL Diagnostic Manager server type remains unchanged after adding or updating the server.

SQLDM-31332 SQL Diagnostic Manager is no longer displaying the “Reading default instances failed:System.InvalidCastException" error
when saving historical snapshots.

SQL Diagnostic Manager now saves the configuration for the newly added Baseline.

When SQL Diagnostic Manager installation completes successfully, the Installshield Logs are deleted.
SQL DM is no longer raising unhandled exceptions when adding a server (Azure, Amazon, Windows).
SQL DM now allows special characters for usernames or passwords.

The grooming is no longer filling the transaction log.

SQL Diagnostic Manager now installs the correct Native Client 2012 version.

SQL DM supports 4K resolution by successfully scaling and displaying screens, icons, and text.

SQL Diagnostic Manager is no longer prompting unhandled exceptions when launching.

Password values are masked in the 'SQLDMMasterInstaller.log'.

After installing SQL Diagnostic Manager, the Connect to SQLDM Repository dialog pops up successfully to specify the
location of your repository.

SQL Diagnostic Manager shows the correct supported version on the Server Wizard.



SQL Diagnostic Manager opens the properties window for unreachable instances in the expected time frame.

Database
The refreshing time for the Database Summary and Availability Groups is shorter than before.

The LastDatabaseCollectionTime database is successfully populated in the repository as well as in the console application
with an offline database.

The SQL Databases summary shows the right values for the Compatibility level column.

DM Console

SQL Diagnostic Manager shortened the loading times in the Queries view and you can properly navigate between tabs in DM
console.

SQL Diagnostic manager now works as expected when navigating across different instances tabs.

SQL Diagnostic Manager Console only installer checks for the right .NET Framework.

SQL DM is no longer showing a refresh error when navigating to the Files Tab under the Database tab.

SQL DM is no longer showing a refresh error when navigating to the Disk Size Tab under the Resources tab.

SQL DM is no longer displaying a refresh error when navigating to the TempDB Summary Tab under the Databases tab.
After a closeout, SQL Diagnostic Manager keeps the servers added to the new custom views created in "My views".
SQL Diagnostic Manager Console works as expected when the Server View Refresh is set at 30 seconds for large

environments.

Disks

Tempdb disks work as expected. They save the drive information of the monitored instance. Besides, the hostname name
returns the server name on which the query runs.

Table

Disabling Collection of Replication Statistics feature is now working correctly.

The ServerActivity table is no longer growing unexpectedly large.

SQL DM now successfully generates the reports and alerts for the fragmentation table.

Analysis
The Analyze tab is working as expected.
SQL Diagnostic Manager shows recommendations correctly when monitoring Azure SQLDB.

SQL DM is no longer having issues when a SQL server account is created by SQL dm Recommended Permissions on-
premises script avoiding raising Probe Permission Violation warnings and collecting OS data.

The prescriptive analysis performs as expected for scheduled jobs.

Services

SQLdmManagementService.exe successfully runs after upgrading SQL Diagnostic Manager.



The SQLdmCollectionService log now shows the expected logging information.

SQLdm Management service now successfully updates the repository.

IDERA Dashboard

The IDERA Dashboard performance was improved and is working as expected.

High Availability Groups

The High Availability Groups successfully collect replication metrics, showing them in the Replication tab of the Server's
Services view.

Days since last backup alert works as expected on secondary replica (always on) instances.

Monitored AlwaysOn servers are successfully contacted, making the AlwaysOn Listener - DB accessible.

Availability Group snapshots displays without any error message.

Upgrade
The Aggregate Data SQLdmRepository works as expected after upgrading SQLDM to 10.4.2.20.
SQL Diagnostic Manager now works as expected when upgrading to the latest version with SQL server 2005 instances.

After upgrading to SQL DM 11.1.6, SQLDM shows correctly the main views ensuring its proper functioning.

Graphs
SQL Diagnostic Manager now correctly displays the graphics from the Dashboard view.

SQLDM-31486 SQL Diagnostic Manager now displays the graph text fully, graphs have a gradient, and all databases are listed under the
databases dropdown.

The overview tab now correctly displays the transactions per second graph.

DBaaS

SQL Diagnostic Manager disables some metrics that Azure SQL DBaaS Template cannot monitor.

The Dashboard of the Overview tab for Azure-managed instances now displays the network widget.

Query Monitor works as expected. It collects no data for Azure SQL Instances when it is not enabled.

SQLDM now allows reconfiguring instances from Windows to AzureDB

The Analysis Configuration view is available for RDS instances.

Query Monitor successfully collects data on Azure SQL MI servers.

The BDaa$S Metric Category has two new subcategories for Amazon RDS and Azure DB.

SQL Diagnostic manager now adds SQL Azure DBaaS instances and successfully refreshes its servers' alerts.

SQL DM Console successfully traces sessions on monitored Azure Managed Instances.

Metrics



The correct value of the OS memory usage metric now displays in the dashboard graph and in the alert configuration.

The Filegroup Space Full(Percent) metric is no longer displaying false data.

The SQL Server services metric status now works as expected with suppression value.
The Advanced Options window behaves as expected with all metrics.

The SQL Server CPU Usage (Percent) metric now reports within the expected values.

SQL Diagnostic Manager now successfully saves the threshold values for the Oldest Open Transaction (minutes) metric.

Alert Response
By default, the Days since last backup metric is deselected in the alert configuration popup for cloud servers.

SQL Diagnostic Manager now successfully triggers an Alert Response when all the custom counters are Critical.

Queries
Query Details are displayed by clicking the globe icon on Statement Mode and Signature Mode.

SQLDM-31540 SQL Diagnostic Manager now includes two options to collect session data for SQL Server: Collect extended data from
session details and Collect extended data from locks and blocks.

The Queries tab gets data loaded faster than before.

The Queries view loads faster and work as expected.

Query Waits

SQL Diagnostic Manager is loading correctly when Query Waits uses Extended Events.

Replication
SQLDM allows monitoring Services from the Replication tab.

SQL Diagnostic Manager now displays the correct Replication Topology data.

Template
SQL Diagnostic Manager works as expected while attempting to apply a template to a monitored instance.

By default, SQL DM automatically selects a template in the Add Servers Wizard.

History Browser

The History Browser Range is properly populated according to the selected time range.

11.1 New Features

® SQL Diagnostic Manager includes full support for Amazon RDS.

® This release includes the completion of Amazon RDS alerts that were added in previous releases. These alerts include:
© New alerts notify if the allocated resources are more than needed.
© Added display for newly collected metrics.

* New Interface User features include Ul Scaling (support for 4K monitors and scaled fonts) and a new dark mode theme.



® This version includes a new Heatmap view and Grid view improvements for monitored servers in the desktop console.
® Amazon RDS SQL Alerts and Alert Templates improvements.
® Prescriptive Analitycs improvements for Amazon RDS monitored servers.

11.1 Fixed Issues

History Browser

The History Browser returns query results within a 60-seconds time frame

Metrics

The SQL Server Agent Job (Percent) metric correctly calculates the percentage value.

The 'Database Full (Percent) metric is working as expected when the Alert Suppression is configured.

The default configuration of the "SQL Server Error Log" metric correctly applies the 10MB file size limit.

The SQL Server Browser metric is no longer raising alerts when only a default instance exists on the monitored server.

The "Days since last backup" metric is no longer raising alerts for read-only databases that have been excluded from the
metric.

The SQL Server Agent Job Failure metric correctly raises alerts as expected.
The "Days since last backup" metric now correctly works in Availability Groups environments.

The SQL Server Agent Status metric correctly returns to an OK state when the service is detected to have been started.

Alerts

SQLDM-29189 The "The deadlock victim was spid 0 with application name ‘unknown' by user ‘unknown' on host ‘unknown" alerts are no
longer displaying.

Alert Response rules are now correctly starting Query-wait statistic collection as it was configured.

Corrected various issues with the Deadlock graphs and Alerts view within the SQLDM Web Console.

Fragmentation alerts are triggering successfully after performing an upgrade.

SQL Diagnostic Manager now raises alerts for Database Full (percent) metric in console when filtering by percentage.
The alert for the "Page Life Expectancy" metric now takes the correct thresholds showing the right alerts.

The advanced "filter by percentage” option correctly raises alerts as expected.

The advanced alert filter for the 'Data File Autogrowth' alert is now correctly excluding databases.

SQL Diagnostic Manager automatically applies certain alert templates based on the server type of the monitored instance.

General
The Database widget under the Overview screen is now displaying data for the historical mode.
Monitored instances are now correctly removed from SQL Diagnostic Manager.

SQLDM-30977 SQL Diagnostic Manager is no longer encountering an overflow error when a monitored SQL Server Agent Job is running
longer than usual.



SQL Diagnostic Manager is correctly sending OK status notifications and email notifications.

SQL Diagnostic Manager desktop console is no longer showing slow performance when monitoring a large number of
instances.

SQL Diagnostic Manager correctly applies baseline settings to other monitored instances.
Customized Dashboards in the SQLDM Desktop Client are now correctly saved in the repository database.
SQLDM successfully applies new baselines' configuration to monitored instances.

Now SQL Diagnostic Manager successfully shows paging graphics in the Memory Screen of the Resources tab.

Services

Improved the stability of the SQLDM Management Service.

Availability Groups

SQL Diagnostic Manager now correctly monitors Availability Group servers with reading/write permissions.

Reports
The Disk Statistic report is now correctly showing the total number of drives of a monitored server.

When the user runs the report for CPU or Memory statistics selecting Show Baseline, it returns Actual and Baseline Stats.

The "Top Query" report now works successfully for all production servers.

The Database Growth Forecast report correctly categorizes system databases when using the database selector.

11.0 New Features

® SQL Diagnostic Manager includes full support for Azure SQL. This feature includes the following resources for the Azure SQL database:
© The compatibility for Azure SQL Managed Instance with on-premises.
© Elastic pools allow you to manage and scale multiple databases.
© Single databases typically are used for development and small apps.
® This release includes the completion of Azure SQL alerts that were added in previous releases. Among other features, these alerts
include:
© New alerts notify if the allocated resources are more than needed.
© New displays for newly collected metrics.
New alert templates with revised thresholds and priority/rank specifically for DBaaS (Azure SQL and Amazon RDS)
This version includes a new server wizard that uses Azure profile credentials, allowing you to discover other Azure DB assets.
Azure profile credentials collect metrics from Azure monitor to extend SQL Diagnostic Manager.
Prescriptive Analytics improvements, including new recommendations for Azure SQL DBaaS and Amazon RDS.

11.0 Fixed Issues

Alerts

SQL Diagnostic Manager now correctly alerts table fragmentation based on the table size configuration.

The advanced Alert Filter for the "Longest Running version Store Transaction (Minutes)" alert is working as configured.
SQLDM-30487 The 'Clear Alert" option in the 'Availability Group Role Change' alert has been restored.

SQLDM shows "Recommendations are available" operational alert in the Active Alert list.

10



SQLDM Disk space alerts are now correctly triggering after an upgrade.
The Disk Full alerts are no longer triggered for excluded disks in the alerts configuration.

SQL Diagnostic Manager now correctly shows the correct alerts and thresholds for page life expectancy metric when using the
Critical-Only Template.

Sl =il The “"Show Historical View" button in the Alerts Tab is now working as expected.

Alert Response

S22 The 'Enable the Query Wait' Alert Action will properly execute when an Alert Response is triggered.

Availability Groups

SQL Diagnostic Manager no longer encounters an error when removing an instance that happens to be a replica within an
availability group.

SQLDM now discovers preferred replica information from Availability Group settings.

Cloud Monitoring

The notifications for blocked sessions and SQL Agent Job Failures when monitoring RDS instances are now working correctly.

Custom Counters

The newly created custom counters are added to the existing templates and can be applied to new servers.

The Custom Counter alerts when using T-SQL script are raising correctly.

Database

The Database status is now displaying accurate status.

Extended Events

SQLDM now correctly add new servers and allows to select 'Extended Events' as the collection method for the Activity Monitor.

The performance of the query that collects Replication Statistics has been improved.

General

SQL Diagnostic Manager now correctly monitors its own repository.

SQLDM installation is now completing successfully when the service account credentials contain special characters.
SQL Diagnostic Manager now correctly reports the Publisher Names for SQL Server 2016 SP2 or later.

Desktop Console Views now correctly keeps the custom views.

IDERA Newsfeed is correctly configured after installing SQL Diagnostic Manager.

SQL Diagnostic Manager now correctly displays baselines.

SQLDM Desktop console now correctly shows the critical SQL Server Service status.

SQL Diagnostic Manager successfully checks SQL Browser Service Alert status when the Remote Administrative connection is
disabled and there is only a default SQL Server instance installed.

11



SQL Diagnostic Manager displays the correct information when you select a secondary tab.
The pause button now correctly works and it is integrated with the refresh button.
SQL Diagnostic Manager now correctly displays the "Session Details" grid.
The Query History view under the Queries tab is working as expected.
SOOI The "View Session Details" option is now correctly working.

SV The “View Locks" option is now correctly working.

Graphs

The 'Disk busy per disk' metric graph now correctly loads under the Disk option from the Resources tab.
The blocking displayed in the reports and in the graphs are synced correctly.

The Alert Configuration window is no longer displaying inaccurate threshold graphs.

Hyper-V

SQL DM successfully connects to Hyper-V Host Configuration.

IDERA Dashboard

SQLDM web console is no longer reporting FIPS compliant environment errors.
The IDERA Dashboard login information is now correctly encrypted.

The SQLDM Web Console no longer encounters exceptions when IDERA Dashboard and the monitored instances are in
different time zones.

The Overview tab in the web console is no longer displaying an exception when clicking the summary under the Active Alerts
widget.

Maintenance Mode

SQL Diagnostic Manager no longer erroneously reporting "Maintenance mode started” when maintenance mode has been
disabled.

Notifications

The Databases category metrics now correctly raise alerts and send email notifications.

Query Monitor
SQLDM now correctly creates historical snapshots when Query Monitor is enabled and configured to use Query Store.

Powerscript now successfully enables Query Monitor.

Reports

SQLDM successfully runs SSRS reports when more than 126 instances are selected.

Services

SQLDM successfully collects information for disk drives volume formatted in ReFS.

12



Upgrade

After upgrading SQLDM from 10.3 to 10.4 version, the Queries tab now correctly loads information.

SQLDM now correctly triggers and notifies alerts for the Session CPU Time after performing an upgrade.

10.5.1 New Features

® SQL Diagnostic Manager now includes a new Server Uptime report.
® This release includes three new default values for the History Browser range.
® The "Days since last backup" alert configuration includes the option to include or exclude Read-Only databases.

10.5.1 Fixed Issues

Alerts

The SQLDM Desktop Console now displays the correct alerts when hovering the mouse over an object on the Server pane.
Alert timeline view is now displaying the time based on the Operating System settings.

SOL Diagnostic Manager now correctly checks and alerts High Fragmentation on the databases.

Alert Suppression for the SQL Server Service metric is now working as expected.

Alert Responses no longer requires the 'Where Alert Rank' option to be enabled in order to be triggered as expected.

Upgrade

Upgrade attempts of SQL Diagnostic Manager should no longer encounter an error regarding a constraint on the
CloudProviders table.

An issue preventing upgrades from versions 10.4.2 and 10.4.3 has been resolved.

The custom Dashboards are no longer being deleted when upgrading from SQLDM 10.4.

Azure

The snapshot data collection is no longer failing for Azure SQL PaaS instances.

SQL Diagnostic Manager now correctly monitors Azure DBaa$S and is no longer displaying errors.
SQL Diagnostic Manager now correctly displays Session details on Azure SQL Database.

SQLDM now correctly displays databases hosted in Azure SQL PaaS.

Desktop Console

Powered off instances are no longer shown as active in the SQLDM console.

The SQLDM Desktop Console will now properly convert the timestamps to local time when viewing the backup/restore history
of a database.

SQL Diagnostic Manager will now generate a warning when the SQLDM Desktop Console is launched if it determines that the
license key will be expiring soon.

Custom Counters
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The Custom Counter reports now correctly displays data.

Query Walits
SQLDM now correctly shows the Query Wait collector status.
The timeline on the Query Waits view will now be displayed in the correct order.

SQL Diagnostic Manager now correctly detects all the specific disk drives for each SQL Server registered.

Services

SQLDM desktop console now correctly connects to the SQLdmManagement Service and is no longer throwing exception errors.

IDERA Dashboard

The SQLDM Web Console now displays timestamps using local time.
The SQLDM Web Console now correctly displays the Last Backup Date of a database.

SQL Diagnostic Manager can now be manually registered in the IDERA Dashboard.

vCenter

vCenter servers for monitored SQL servers in SQLDM can be added without problems.

Metrics

*The 'Days since last backup' metric has been updated to include additional advanced options specific for availability groups.

SQLDM now properly monitors the status of DTC and SQL Server Agent when collecting operating system statistics using OLE
Automation.

Reports

The Disk Space Usage report in the SQL Server Reporting Services portal is no longer asking the value for the Disk parameter.

SQL Diagnostic Manager now collects deadlocks in Session > Blocking View and in Reports when using Extended Events or
SQL Trace.

Database Growth Forecast report now correctly shows sufficient data.

Availability Groups

Soib VBB The "Aggregate Data SQLdmRepository" and "Groom SQLdm Repository" SQL Agent jobs now correctly run when the SQLDM
Repository Database is hosted in an availability group.

SQL Diagnostic Manager is now showing correct mount points for monitored secondary replicas.

The databases in an SQLDM Availability Group now correctly capture growth statistics.

SQLDM Desktop Console no longer crashes when accessing the Availability Group view under Databases.
Improve the load time on the Availability Group databases view.

SQL Diagnostic Manager is no longer displaying errors and is successfully connected to servers holding repositories in an
availability group without a listener.

SQLDM is no longer having problems collecting Database size data when monitoring Availability Groups instances.
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Wait Statistics

The Wait statistics are no longer displaying inconsistent values.

Deadlock

The SQL Queries from the deadlock drop down output are no longer truncated.

Other issues

SQLDM now correctly shows the closest historical snapshot when switching servers.
SQLDM no longer generates login failures for 'SQLDiagMgr' in the SQL Server Error Log.
SQL Diagnostic Manager now correctly shows the table sizes.

SQLDM now correctly collects the CPU virtualization information on Hyper-V virtual environment.

10.5 New Features

® SQL Diagnostic Manager now includes Prescriptive Analysis improvements (embedded SQL Doctor), updated user interface that
matches SQL Doctor workflows, and updated recommendations (specifically for Azure SQL and Amazon RDS).

® This release includes Cloud DBaaS user interface improvements that ease the management of Azure SQL and Amazon RDS
management supported metrics.

® SQL Diagnostic Manager now includes Alerting improvements:

© New alert templates with revised thresholds and ranks.

New conditions for Alert Responses.

New Alert filter to avoid false positives from spikes, filter by percentage of time over a period exceeding threshold.

PowerShell command to Apply Alert template.

New Alerts and metrics for Azure SQL and Amazon RDS specifically.

All alert priority levels were updated for existing alerts and for user customization.

New alert template reports.

O O O O O O

10.5 Fixed Issues

Alerts
The Alert Suppression settings for the Availability Group Synchronization Health metric now functions as expected.
Alert Summary for the Blocking Session Wait Time (Seconds) metric is not displaying time using the local time zone.

The alerts "SQL Server Agent unable to monitor" and "WMI service is unavailable" are no longer triggered when the
monitored servers are successfully connected to the WMI service.
Analysis

SQL Diagnostic Manager is no longer prompting an error when performing an Analysis, which was caused by the Prescriptive
Service not installing "TracerX.Logger.dlll" file.

History Browser is no longer used for Prescriptive Analytics with the revised interface.

SQL Diagnostic Manager now successfully completes analysis and the results are displayed as expected.

Web Console

The SQL Diagnostic Manager Web Console correctly displays the statuses of monitored instance.
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The SQL Diagnostic Manager Web Console now correctly honors the Application Security settings that is configured in the
SQL Diagnostic Manager Desktop Console.

The IDERA Dashboard now correctly displays the federation drop down menu.

Metrics

The 'Days since last backup' metric no longer generates alerts for databases that have never been backed up

The PowerShell now correctly works when the $AlertText is used for the Blocked Sessions Wait Time (Seconds).

When configuring the "Oldest Open Transaction" metric, SQL Diagnostic Manager now correctly saves the exclusion filter
value when wildcards are used.

Desktop Console

Improved the performance of the SQL Diagnostic Manager Desktop Client when updating properties of a monitored SQL
Server instance.

Index rebuilding operation in SQLDM desktop console now correctly works and is no longer displaying errors.

Reports
The Deadlock Report now correctly displays all the information about the deadlocks occurred in the monitored instances.

SQLDM-29427 The error "Failed to enable constraints. One or more rows contain values violating non-null, unique, or foreign-key constraints"
is no longer displaying when running the "Detailed Session Report".

The Deadlock Report now correctly shows the total number of deadlocks.

The Database Statistics report no longer encounters a timeout error when generating the report.

The Detailed Session Report now successfully deploys to SSRS.

Services

When monitoring a SQL Server instance using a privilege minimized user, Query Monitor and Wait Statistics collection will
now resume upon a restart of the SQL Diagnostic Manager services.

The SQLDM Management Service no longer crashes when a server has been registered as a Linux instance.

SQL Server supported versions
SQL Diagnostic Manager now correctly monitors SQL Server 2000 instances.

SQLDM now correctly monitors SQL Server 2005 instances.

The error "SQL Agent unable to monitor" is no longer prompting when monitoring instances running specific SQL Server
versions.

Memory

SQLDM now correctly shows the OS memory usage on the newly added servers.

Upgrade
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The "Error interpreting File Activity Collector: Invalid column name ‘unused_size™ error is no longer displaying after upgrading
to SQLDM 10.3.

The SQLDM desktop console now correctly works after an upgrade to 10.3.1 version.

Sysadmin Permissions

SQLDM-29931 SQL Diagnostic Manager no longer generates an error message indicating that sysadmin rights are required in order to collect
OS Metrics.
Mirroring

SQLDM now correctly refreshes the Mirroring history of a database.

Query Waits

The refresh error when navigating in the Query Waits screen is no longer displaying.

Azure

SQL Diagnostic Manager is no longer generating an error related to Procedure Cache when monitoring Azure SQL Database.

10.4 New features

® Visual Query Plans is now available for launch in the Windows Client context from any query.

® SQL Diagnostic Manager includes an improved collection of Extended Event query plans.

® This release includes new options to exploit Query Store collections for query waits, query plans, and query performance.
® Improved IDERA Dashboard with new alerts grid and instance lists.

10.4 Fixed Issues

Maintenance Mode

SQLDM-27123 Enabling maintenance mode on an ad-hoc basis no longer purges the scheduled maintenance mode settings. This allows
users to easily restore schedule maintenance mode settings as needed.

Azure Databases

The SQL Diagnostic Manager Desktop Client is no longer returning error messages when viewing data on monitored Azure
Databases.

Metrics

The metric "SQL Server Log size" is triggering alerts as expected.

Web Console
The SQL Diagnostic Manager Web Console is correctly reporting the statuses of the monitored SQL Server instances.

Improved performance of the SQL Diagnostic Manager Web Console.

The SQL Diagnostic Manager Web console correctly recognizes users configured in Application Security.
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Deadlocks

SQL Diagnostic Manager is no longer reporting persistent deadlocks from the [p_InsertDatabaseSize] procedure.

Desktop Console
The SQL Diagnostic Manager Desktop Client now correctly displays dates based on the Operating System settings.
The SQLDM Graphical User Interface now correctly responds and no longer hangs.

Improved performance when updating Monitored SQL Server Properties within the SQL Diagnostic Manager Desktop Client.

The Desktop console is no longer displaying random exceptions.

Alerts

SQL Diagnostic Manager now correctly sends alerts in a timely manner via email.

SQLDM now correctly imports Alert templates.

When hovering over a monitored instance on the Servers panes view, the displayed tooltip now correctly displays the current
active alerts.

The Alert suppression threshold now correctly works and triggers alerts as expected.

Powershell

The PowerShell now correctly works when the $AlertText is used for the Blocked Sessions Wait Time (Seconds).

Table Statistics

Table Statistics collection is now properly excluding specified databases that are hosted on a case sensitive collation.

Reports

The Enterprise Summary report now correctly lists the SQL Server version of the monitored instances.

Services

Improved memory consumption by the SQLdm Management Service.

SQLDM-29505 The SQLdm Management Service remains in a running state if the SQL Server instance hosting the SQLdm Repository
database is unavailable.

SQL Diagnostic Manager will correctly report the status of the SQL Server Agent Service on SQL Server 2008 R2 instances.

10.3.1 New features

No new features for this release.

10.3.1 Fixed Issues
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Desktop console

The SQL Diagnostic Manager Desktop Client is no longer encountering latency issues when navigating between monitored
instances.

Upgrade

SQLdm Collection services is no longer causing high CPU and network usage after performing an upgrade.

After performing an upgrade to SQL Diagnostic Manager 10.3, the job "Aggregate Data SQLdmRepository" is no longer
reporting timeouts.

The SQLdM Management service starts automatically after the upgrade.

10.3 New features

® SQL Diagnostic Manager is able to monitor SQL Server 2017 instances running on Windows or Linux operating systems.

® SQL Diagnostic Manager now includes a new operator security role.
® This release include new grooming and aggregation options for long term forecasting metrics for disks, databases, and tables.

10.3 Fixed Issues

Alerts

SQL Diagnostic Manager now correctly imports alert templates.

The alert suppression threshold now correctly works in SQL Diagnostic Manager.

SQLDM Desktop Client

An unhandled exception is no longer being encountered when accessing the Queries tab in the SQL Diagnostic Manager
Desktop Client.

Amazon RDS

When monitoring an Amazon RDS SQL Server instance, SQL Diagnostic Manager is no longer encountering the ‘The
EXECUTE permission was denied on the object 'xp_fixeddrives', database ‘mssglsystemresource’, schema 'sys” exception.

Services

The SQLdm Management Service is no longer encountering issues when reading metric threshold settings from the repository
database.

Custom Counters

S SQL Diagnostic Manager is no longer reporting the error: "Unable to connect to SQL Instance - Custom counters file view is out
of memory"

10.2.3 New Features

No new features for this version.

10.2.3 Fixed Issues
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Installation and Upgrade

® The reported issues when re-installing SQL Diagnostic Manager with a pre-existing repository, have been solved.
® The ongoing SSL errors when attempting to install SQL Diagnostic Manager have been solved for this version.

® The Unable to monitor error "Error interpreting Job Alerts Collector: Invalid column name ‘job_last_run_duration." is no longer displaying
when running an upgrade.
® SQL Diagnostic Manager now correctly displays historical snapshots after upgrading.

Analysis

® SQL Diagnostic Manager now correctly displays accurate results when running an Analysis.

Availability Groups

® SQL Diagnostic Manager now correctly connects to Availability Group listeners, and monitoring AlwaysOn instances.

Graphs

® The Session Statistics graph is no longer having issues showing the Y-axis values of the Transactions per Minute graph.

WMI

® The reported problem of WMI not being available on some servers has been fixed.

Dashboard

* |DERA Dashboard is no longer reporting maintenance mode status in actively monitored instances.

®* The IDERA Dashboard is displaying data in the Queries view screen, the message "No Data Available. Please try after some time" is no
longer showing.

®* The IDERA Dashboard is now allowing access to the web console through domain groups and individual accounts.

® Users are no longer having issues when they manually register SQL Diagnostic Manager in the Dashboard.

Services

® The error displayed in the desktop console, when users were trying to connect to the SQLdm Management service, has been fixed.
® SQL Diagnostic Manager is now correctly firing alert emails when the SQLdm Collection service is down.

Metrics

® The changes that users applied to the metrics in the default templates are no longer causing errors.

Grooming

® SQL Diagnostic Manager is no longer displaying erroneous time-range data in the ChangeLog and is complying the user grooming
configuration.
® The DatabaseFileStatistics grooming is running as expected and it has stopped timing out.

SQLDM Mobile

® The reported problem when running queries in SQLDM Mobile is no longer an issue in Chrome and other browsers.

Alert Rules and Alert Responses

® SQL Diagnostic Manager now correctly generating emails for all the configured Alert Rules that has the "Where metric severity has
changed" option enabled.
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SQLDM is now sending alerts to SCOM for the metrics and severities specified in the rule, without disruption.

The Alert Response "Send all Alerts to Scom as Alerts" is no longer having issues when the default configuration is changed.
When the default configuration is changed in the Alert Response "Send all Alerts to SCOM as Alerts", these changes are correctly
applied and work as expected.

Alerts

SQL Diagnostic Manager is notifying the user by email when the alert "Blocking Session Wait Time" has a critical status.

Other issues

The Sessions, Queries, and Query Waits screens in the desktop console are displaying data normally.

The errors in the details of a Deadlock occurrence caused by an "intra-query parallelism deadlock" have been fixed.

SQLDM now correctly displays query data statements. All queries are matching up with their associated databases.

The error: "Key already exists, Parameter name key (Infragistics2.Shared.v10.3)" is no longer displaying when removing the Details
column in the Signature Mode screen located in the Query Monitor.

The problem that users had when creating custom dashboard in the SQL Diagnostic Manager web console, has been solved.

The friendly names are no longer being removed by SQL Diagnostic Manager.

10.2.2 New features

Cluster environment

A UNC path is set for DataPath for the SQLDM services in a cluster install.

Reports

SQL Diagnostic Manager runs the Detailed Session report. This report provides detailed session information of your selected SQL
Server instance and is included under the Resource Analysis Reports.

SQL Diagnostic Manager has included the Deadlock Report. This report lets you analyze deadlocks on your SQL Server instance and is
included under the Monitor reports.

SQL Diagnostic Manager allows you to exclude one or more disks when running the Disk Space Usage report.

10.2.2 Fixed issues

IDERA Dashboard

The errors "Error while fetching data” displayed in the IDERA Dashboard overview widgets are no longer shown.

The IDERA Dashboard is no longer having issues when displaying data for SQL Diagnostic Manager groups and individuals login
accounts.

SQL Diagnostic Manager is no longer showing slow performance in the IDERA Dashboard.

The widgets are displaying without problems when SQL Diagnostic Manager has been registered again in the Dashboard.

Web console

SQL Diagnostic Manager is no longer displaying the error "Page not found" after entering valid credentials in the web console.

The web console is no longer having issues displaying data.

TempDB

The Tempdb summary screen is no longer displaying unhandled exceptions. The widgets are updating as expected.
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Extended Events

® The query information is collected through Extended Events smoothly and is visible in all instances.

Reports

® When exporting an Alerts report as XML in the Dashboard, the "org/apache/xmlbeans/XmlObject" error is no longer generated.

Query Plan

® The Query plan information is collecting and populating to the Dashboard without problems

Metrics

® The "Availability Group Role Change" metric is generating alerts and notifying users by beeper and email alerts. This metric is generating
OK status and working as expected.

Resources

® The Disk selection located in the Resource tab of the desktop console is no longer having issues when displaying data.

® Users are no longer getting the "The stored procedure 'p_GetDiskSizeDetails' doesn't exist (System.Data)" error, when they go to the
Disk Size screen located in the Resources tab of the desktop console.

Availability Groups

® The availability groups historical views are displaying accurate information. The Availability Group is no longer having issues when
browsing back to previous snapshots.

Alerts

® The alerts status is working as expected when the metrics are set to run alerts in specific thresholds values.

® The thresholds of the metric "Availability Groups Redo Queue" can be extended to higher values.

® The sudden spikes and drastic drops of SQL Diagnostic Manager alerts are no longer occurring

® When the threshold values of a custom counter are updated, the changes are reflected into the linked instances.

® SQL Diagnostic Manager is no longer showing problems while displaying deadlocks information in the Alerts tab of the desktop console.
® The Alerts summary is displaying the correct time zone in the alerts details description.

Other Issues

® SQL Diagnostic Manager is no longer having issues when creating shortcuts for all users.

® SQL Diagnostic Manager is no longer displaying installation failed messages.

® The blocking alerts triggered with no description data when SQL Diagnostic Manager is upgraded, are no longer an issue.

® The exception filter wildcard is working without problems after SQL Diagnostic Manager is upgraded.

® When a user clicks the "Optimize Script" button in the Finding Text of the Analyze option, SQL Diagnostic Manager is able to receive
SQL Script without problems.

® After installing SQL Diagnostic Manager, an unhandled exception is shown together to the "Connect to Repository" message.

® SQL Diagnostic Manager is no longer displaying inconsistent Wait stats.

10.2.1 New features
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No new features for this version.

10.2.1 Fixed issues

SQLDM Desktop console

The exception displayed when accessing Sessions > Locks is no longer shown.

The Sessions Details view and the Locks view are displaying normally. The “Sysadmin privileges to obtain data for this view” message is no
longer showing in these views.

Grooming

SQL Diagnostic Manager is no longer displaying false grooming alerts.

10.2 New features

SQL Diagnostic Manager

SQL Diagnostic Manager has performance improvements, focus on an extensive scalability and user productivity improvements which involve
faster startup time and faster connectivity between SQL Diagnostic Manager and SQL Workload Analysis.

SQL Workload Analysis integration

SQL Diagnostic Manager allows you to launch SQL Workload Analysis in context of your monitored server from the desktop console and the
IDERA Dashboard. For more information, see Launch SQL Workload Analysis.

Time-based drilldown any graph in the desktop console and in the web console to select any time range to zoom in for more detail.

SQL Workload Analysis launch points in different components of SQL Diagnostic Manager desktop and web console.

History browser

SQL Diagnostic Manager has a new History Range Control in the desktop console and web console that allows you to choose the time range you
need, specifying the start time and end date; as well as current snapshot.

10.2 Fixed issues

Always On availability groups

An issue that caused CPU spikes on the primary node of a monitored Always On availability group has been fixed.

Alerts

SQL Diagnostic Manager is no longer reporting problems when displaying alerts and snapshots.
The active Alerts are displayed normally in the SQLDM web console.
The "Unable to monitor” alert related to the following description: "[Server Name]Error interpreting Job Alerts Collector: Column name or number

of supplied values does not match table definition. [Server Name] Error executing Job Alerts collector: Column name or number of supplied
values does not match table definition" is no longer displaying after an upgrade.

Services
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The high memory consumption and the constant crashing of the SQLdm Collection service and the SQLdm Management service are no longer
occurring.

An issue that would stop the SQLDM Collection Service from monitoring one or more SQL instances has been fixed.

The SQLDM Management Service no longer crashes when it encounters a malformed Alert Rule.

Cloud instances

While monitoring RDS SQL Server instances, SQLDM is no longer receiving errors while navigating through the panes in the desktop console.

SQL Diagnostic Manager provides the following new features and fixed issues.

10.1.4 New features

No new features

10.1.4 Fixed issues

Alerts

® To provide a clearer understanding of what the “Distribution Latency (Seconds)” metric is measuring, the description of the metric and

summary of raised alerts has been updated.

SQLDM is now displaying Informational Alerts for SQL Server Agent Long Running Jobs.

SQLDM is displaying alerts in Dashboard and the desktop console regardless the ‘Region and Language’ settings.

"Days since last backup" alert is being triggered considering the threshold values configured in the alert configuration template.

When the log file is filled up in a database, the Log Full (Percent) alert is being triggered normally and the LogSizelnKilobytes and

PercentLogSpace columns are not showing NULL value when the log percent retrieved is greater than 100%.

The exception filter wildcard is working normally and is no longer causing undesired alerts.

® The Filegroup Space Full (Percent) alerts for filegroups that are on the same disk are showing the correct values for the space full
percentage.

® The number of days since last backup are now correctly displayed for daily backups databases. SQLDM is now generating the “Days
since last backup” alert for databases that include a space at the end of the database name.

® SQLDM is no longer receiving continuous OK status alerts for the Log Full (Percent) and Database Full (Percent) metrics.

Alert response

® Alert Response triggers normally when a server is added to a tag.

Availability Groups

® The "Days since last backup" metric is now checking the backup preferences of databases patrticipating in an Availability Groups prior to
raising alerts.

® SQL Server Agent jobs created for SQLDM are no longer encountering errors on secondary nodes when the SQLDM repository is
hosted in an availability group.
®* When a member of a database is on a read-only role, SQLDM is no longer displaying critical alerts on the Availability Groups databases.

Custom Counter

® The Custom Counter SQL Script text window is resizing to the popup window size.

Dashboard

® The Dashboard and SQLDM are reflecting the same per-database data size usage.

® The error "Something unexpected happened Java.Null.Pointer exception” is caused by a compatibility issue between products in the
IDERA Dashboard is no longer displaying.

® Inthe IDERA Dashboard overview, the SQLDM Instances status widget is no longer having issues displaying the number of servers
or the status of the servers. A compatibility issue among IDERA products within IDERA Dashboard caused this issue.
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Data collection

® SQLDM is no longer having issues collecting log errors with a Severity higher than 21.

Graphs

® All graphs are displayed correctly and with all the information complete.

Logs

® The upper limits on High Availability Log Send Queue size alert triggering have been extended to 999 million logs.
® Users can now review the SQL Server Error logs. The error "Error reading SQL 2005 SQL Server log: System.InvalidCastException:
Specified cast is not valid" is no longer showing up.

Queries

®* The SQLDM console is now refreshing the list of the resulting queries in the Statement Mode View. Improvements to the Statement
Mode view in the SQLDM console to allow a list of queries.

® The date ranges are now consistent when switching among Signature mode, Statement mode, and Query History screen. Query history
now displays details about the query selected.

® Improvements to the query used to populate the data on the Alerts view in the SQLDM Desktop Console.

® ‘Top Queries’ and ‘Query Overview’ generate successful reports without timeout or expired messages.

Replication Monitoring

® When using replication, SQLDM is displaying the correct publisher status.

Reports

® SQLDM is triggering accurate results when running "Top Queries" reports.
® SQLDM reports that are deployed to SSRS are now generating charts correctly.
® Index improvements to improve the duration it takes to run the Database Statistics report.

Repository

® There are no longer issues in the Repository connection application when using Management Service Utility to reconfigure repository
connection for a management service.

® An error is no longer being generated on the Overview tab when the SQLDM repository database is hosted on a SQL Server 2005
instance. The error that was previously generated was “An error occurred while refreshing.Exception type: System.Data.SqlClient.
SqlException. Message: Type Time is not a defined system type.”

Sessions

® Users are no longer encountering issues when viewing locks under the Sessions tab. The view is updated automatically.
® The Lock section under Sessions is no longer showing "Sysadmin privileges are required to obtain data for this view" message.

SQL Server Agent

® The SQL Server Agent Long Running Job (Percent) value is now properly calculated in the alerts screen.

Web console

® Date/Time values stored in the SQLDM repository database are stored in GMT format. The SQLDM web console now converts the GMT
format to the local time zone.

®* The SQLDM web console is no longer displaying deleted databases.

® The Sessions view in the SQLDM web console is displayed with no errors.

® |nstances in Maintenance Mode are no longer displaying health status or alerts in the web console.
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Other issues

SQLDM is no longer having timeouts when viewing large Databases under table and indexes.

SQLDM displays tables normally without delays.

The “Days since last backup” metric is only available for Online databases.

The index DatabaseStatistics has been added to the UTCCollectionTime nonclustered index for a better performance.

The IDERA Products option in Help Menu on the SQL Diagnostic Manager Desktop Console is linked to the navigation page and is no
longer prompting error.

SQLDM is no longer having issues when using a non-standard Short Date format.

® The Monitored SQL Server Properties dialog box in SQLDM Desktop console is opening without any timeouts.

10.1.1 New features

SQL Diagnostic Manager allows you to launch SQL Workload Analysis in context of your monitored server from the desktop console and the
IDERA Dashboard. For more information, see Launch SQL Workload Analysis

10.1.1 Fixed issues

Reports

The Transaction Log Statistics report is no longer showing erroneous used size values.

The Disk Space History report is no longer encountering the 'String or binary data would be truncated' error.

Query Monitor

Query Monitor is no longer reporting a captured stored procedure as both a SQL Batch and a Stored Procedure when Query Monitor is
configured to collect queries using Extended Events.

Query monitor is no longer capturing queries that do not meet threshold definitions.

Procedure Cache

SQLDM is no longer having issues when accessing to the Procedure Cache tab.

SQL Server CPU Usage (Percent)

SQLDM is no longer reported inflated values for the SQL Server CPU Usage (Percent) metric on monitored instances running on systems with
hyper-threaded CPU.

Server Log file

The IDERA Dashboard is no longer recording the user login and password in the server.log file.

Cloud instances

SQLDM is no longer encountering the 'Read login mode failed:System.IndexOutOfRangeException: Index was outside the bounds of the array'
error while attempting to retrieve live data from a monitored instance running on Amazon EC2.

Blocked Sessions Graphs

The Blocked Sessions graphs report correctly the number of deadlocks that were detected by SQLDM.

Prescriptive Analysis
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The Prescriptive Analysis is no longer encountering the ‘Error converting data type nvarchar to float’ error while saving the collected data into the
SQLDM repository database.

Grooming

SQLDM is now grooming the DatabseFileStatistics table in the SQLDM repository database.

Alerts

The Alerts pane is no longer having issues loading any active alerts due to a timeout with the query being issued against the SQLDM repository
database. This query has been optimized to retrieve the list of active alerts in a timely manner.

10.1 New features

Health Index Calculation

Modify the index calculation scale factor for each type of alert. Assign instances more or less importance in the overall heatmap ranking by
modifying their scale factors. For additional information, see Heatmap Calculation Configuration.

Use Instance Friendly Name in Web Console

The Friendly Name assigned in the Desktop Console can also be used in the Web Console. For more information, see Assign a friendly name to
your SQL Server instance.

Query Waits Alert Response Action

Collect more information by enabling the collection of Query Waits when the criteria for an alert response rule is met. For additional information,
see Query Waits Action Provider.

SCOM Alert Response Action

Send an Event or an Alert to SCOM in response to an alert when the criteria for the new alert rule is met. For additional information, go to SCOM
Event Action Provider and SCOM Alert Action Provider.

PowerShell Alert Response Action

Specify a PowerShell script to run in response to an alert when the criteria for the new alert rule is met. For additional information, see PowerShell
Action Provider.

PowerShell Snap-in Added Functions

Customize your monitored SQL Server properties with new cmdlets. For more information, see Customize your Monitored SQL Server properties
within PowerShell.

Independent Scheduling of Multiple Baselines

Add and schedule multiple baseline periods in addition to the default baseline. For additional information, see Schedule multiple baselines.

10.1 Fixed issues

General
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The SQLDM Desktop is no longer showing slow performance that was caused by retained data from deleted instances.

Grooming process

The grooming process has stopped the exceeding growth of the SQLStatementsOverflow table.

Monitor AlwaysOn Availability Groups

The monitored Availability Group Listeners no longer have issues gathering information from the primary replica.

The “Unreadable availability replica” status is no longer displaying in the databases that are part of AlwaysOn Availability Groups.

Collection service

Enabling maintenance mode for all monitored instances is no longer causing SQLDM Collection Service crash.

Troubleshoot WMI connectivity issues

After troubleshooting the WMI connectivity issues the “WMI is not available on the server” alert is no longer displaying.

10.0.2 New features

There are no new features.

10.0.2 Fixed issues

General

®* The "DtcService Status" error displayed after selecting a view or tag in the desktop client, when configured with the Hungarian system
language, no longer occurs.

® An issue preventing SQL Diagnostic Manager from registering instances using long and complex SQL Authentication passwords no
longer occurs.

® The Snapshot Selection window now displays correctly the AM and PM time symbols when using French (Swiss) regional settings in
SQL Diagnostic Manager.

® The SQL Server 2012 and SQL Server 2008 versions are now displayed correctly in SQL Diagnostic Manager.

® Anissue preventing SNMP Traps to work properly no longer occurs

Report

® An issue preventing the Top Queries report from displaying accurate results is fixed.

® There are no longer any issues preventing the Top Servers report from rendering properly or deploying into a Microsoft Reporting
Services Server.

® A data type conversion error no longer occurs when running the Top Queries report in SQL Diagnostic Manager.

Query waits

® An issue preventing Query Waits from being retrieved historically no longer occurs.

Query Monitor

® An issue causing Query Monitor to be disabled after Maintenance Mode no longer occurs.

Alerts

28



® There are no longer any issues preventing alert templates from being edited after making changes in the "Days since last backup" metric
configuration.

® There are no longer any issues causing operational query monitor alerts to be triggered repeatedly due to an XML parsing error in SQL

Diagnostic Manager.

The Days since last backup alert now works seamlessly in an availability group environment.

The Days since last back up alert is no longer triggered for database snapshots.

The Days since last back up alert is no longer triggered for mirrored databases.

There are no longer any issues preventing alerts from being triggered properly in the desktop console after upgrading SQL Diagnostic

Manager.

® The details section of the Alerts view now displays the full list of recorded error log messages for SQL Server Error Log alerts.

Tables & Indexes view

® There are no longer any issues causing data to populate slowly and timeout messages when accessing the Tables & Indexes view.

Custom Counters

® Monitored SQL Server instances now remain linked to custom counters when setting maintenance mode with PowerShell.

10.0.1 New features

There are no new features.

10.0.1 Fixed issues

General

® The desktop client is no longer unresponsive when the registered instances are unable to connect.

Blocking Sessions view

® The bottom chart of the Blocking Sessions view is now displaying a correct blocking session count.

Reports

® There are no longer any issues preventing the Top Servers report from rendering properly or deploying into a Microsoft Reporting
Services Server.

10.0 New features

Prescriptive analysis

Run or schedule a prescriptive analysis or workload analysis on a specific SQL Server instance to identify and resolve common areas of SQL
Server performance problems such as queries, database objects, and more. The analysis results in useful configuration and tuning
recommendations that you can apply. For additional information, see Analyze your SQL Server instance.

Multiple baselines

Define and schedule any number of baseline periods. View relevant baseline in effect in various metric graphs plus enable alerting and
recommendations to review thresholds. For additional information, see Configure server baseline options

Multiple SQL Diagnostic Manager custom dashboards
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Graphically create multiple custom dashboards by dragging-and-dropping widgets. Easily control time range across widgets, add, edit, duplicate,
and remove dashboards. Use your multiple dashboards to compare metrics across your monitored instances. For additional information, see Cre
ate custom dashboards

Import/Export alert response

In SQL Diagnostic Manager 10.0 you can select alert responses to import or export . For additional information, see Configure how SQL
Diagnostic Manager responds to alerts .

Import/Export wizard

The Import/Export wizard centralizes all SQL Diagnostic Manager import and export capability for customization. In one stop import or export all
your alert responses, alert templates, custom counters, and custom reports. For additional information, see Use the SQL Diagnostic Manager
Import/Export wizard

Top Servers report

Generate a report on a specific metric (e.g. CPU utilization) and clearly view the top 10 servers with the highest threshold over a given timeframe.
For additional information, see Top servers custom report.

Self-service licensing model

In SQL Diagnostic Manager 10.0 you can login to the Idera Customer Portal or launch the license manager utility to generate your own license
keys. For additional information, see Generate a new license key.

Web console improvements

Federated Overview screens

Access aggregated views and functions for all your SQL Diagnostic Manager Repositories connected to the IDERA Dashboard. Filter results by
tags, a specific SQL Diagnostic Manager Repository, a specific SQL Server Major version, or an instance name through wildcard characters. For
additional information, see Navigate the web console dashboard.

New common Dashboard widgets

Use any of the eighteen Top X widgets available for customization in the Overview tab or the Details view of the IDERA Dashboard. For more
information on this feature, see Navigate the IDERA Dashboard

New color-coded Alerts Timeline view

Easily identify the highest alert for your monitored instance at any point in the time and the highest alert for a specific category. Select a default
time range or a customized one, filter timeline results by category and display order. For more information on this feature, see View your SQL
Server alerts.

Query Waits view enhancements

Re-designed Query Waits by Time and Query Waits by Duration views. New Wait Category dimension to display, selectable time range, and
improved navigation from one view to another. For more information, see View your SQL Server query waits information.

Databases Summary view enhancements

Select multiple databases to display as horizontal stacked bar charts. For more information, see View your SQL Server databases information.

Collapsible side panel

Hide or expand the side panels of the SQL Diagnostic Manager Overview view. For more information, see Navigate the web console dashboard.
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10.0 Fixed issues

General

® This release fixes an issue with unsigned executables that occasionally blocked upgrades or resulted in security concerns that files may
be corrupted. In SQL Diagnostic Manager 10.0 executable binary files are digitally signed.

Web console

® An issue preventing the Databases view of the web console from populating when a database is offline no longer occurs.

Newsfeed

® An issue preventing users from creating a Newsfeed user account no longer occurs.

9.1.2 New features

There are no new features.

9.1.2 Fixed issues

General

® An issue causing a management service memory leak no longer occurs.

IDERA Dashboard

® A registration issue causing the web console and IDERA Dashboard to display blank no longer occurs.

Disk view

® An issue preventing the Disk Busy Total or Disk Busy Per Disk graphs from displaying data no longer occurs .

9.1.1 New features

There are no new features.

9.1.1 Fixed issues

General

® An issue preventing OS metric statistics from being collected and disk drives not to be discovered after upgrading to 9.1, no longer
occurs.

Single instance dashboard

® This release fixes an issue that prevented the databases tab of the single instance dashboard from populating when a database was set
offline.
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Deadlocks
® An issue causing deadlocks in the SQL Diagnostic Manager Repository database after upgrading to SQL Diagnostic Manager 9.1, no
longer occurs.
Mount Point
® An issue preventing filegroup statistics to be saved to the SQL Diagnostic Manager Repository, no longer occurs. This issue was specific

to filegroups aiming at Mount Point drives.

Alerts

® An issue causing the Filegroup Space Full (percent) alert to trigger with higher than normal percentage values after upgrading to SQL Dia
gnostic Manager 9.1, no longer occurs.

Hyper-V

® A permissions issue preventing the Hyper-V server from collecting data and displaying the same, no longer occurs. Note that SQL Diagno
stic Manager uses the direct WMI credentials established by the user under OS Metrics > Properties to obtain data for the Hyper-V
host. To gather VM metrics SQL Diagnostic Manager uses the VM credentials assigned by the user under Tools > VM Configuration.

9.1 New features

Web console improvements

Aggregated views across multiple SQL Diagnostic Manager repositories
SQL Diagnostic Manager users are now able to access aggregated views and functions for all their SQL Diagnostic Manager Repositories

connected to the IDERA Dashboard. For example, the option to filter results by a specific SQL Diagnostic Manager Repository are included. For
additional information, see Navigate the IDERA Dashboard.

Launch the SQL Diagnostic Manager Console from various views
In SQL Diagnostic Manager 9.1 users can launch the SQL Diagnostic Manager Console from the Thumbnail and Heatmap views, as well as from

the Alerts Detail screen. Upon clicking the SQL Diagnostic Manager icon blocked URL , users are directed to the associated instance. In addition,
users can navigate back to the Overview tab of a specific single instance dashboard from the SQL Diagnostic Manager Console.

Adjustable panels in key web console views

The panels in the list, thumbnail, and heatmap sub-views of the SQL Diagnostic Manager web console are now adjustable, allowing users to
expand panels to fit the page or to return to previous setting.

Improved thumbnail sub-view

The thumbnail sub-view provides you with a graphical replication of your monitored SQL servers. The thumbnail sub-view is now sorted by
criticality of worst alert and it includes CPU, Memory, 1/O, and Response Time sparkline graphs for a 1-hour view so that users can obtain an
overview of key metrics quickly. For additional information, see Use sub-views to identify and diagnose issues.

Improved heatmap sub-view

The heatmap sub-view provides you with a visual overall status of your SQL Server environment in the form of a grid of color coded squares that
contain a health index. Through its color scheme and health index, you can easily identify which of your monitored instances need the most
attention. Each square in the heatmap sub-view represents a monitored instance. For additional information, see Use sub-views to identify and
diagnose issues.
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New web console widgets

SQL Diagnostic Manager 9.1 contains several new widgets for practical access to specific information in both the IDERA Dashboard and the web
console:

® Overview tab widgets. Overall status , Instance status , Instance list , and Active alerts list.
® Details view tab widgets. Top instances by alert count, Top databases by alert counts, Top instances by CPU usage, and Alert counts

by category.
® Resources tab widgets. Top sessions by active CPU and Top sessions by I/O activity.

Monitoring of non-query activities with Extended Events

In SQL Diagnostic Manager 9.1 collection of non-query events data such as deadlocks, Autogrow, and blocking is performed through Extended
Events by default for SQL Server instances running SQL Server 2012+. First introduced in SQL Server 2008, Extended Events provide a new
mechanism to capture information about events inside the Database Engine and diagnose performance problems. This functionality is highly
efficient and lightweight, resulting in minimum impact on your SQL Server performance. For additional information, see Set activity monitor options

Integration with the IDERA community site
SQL Diagnostic Manager 9.1 allows users to share product content , saving valuable resources. With these new features you can import and

export custom counters, custom reports and alert templates. For additional information, see Use custom counters to track metrics, Custom reports
, and Configure alert templates.

Filegroup and Mount Point monitoring improvements

Configurable database filegroup alerts are now available

The Filegroup Space Full (Percent) and the Filegroup Space Full (Size) alerts allow users to track available space at the filegroup level.

New Disk Size view
The new Disk Size view in the Resources tab allows users to view key statistics on all monitored disk drives, including mount point drives, in their

environment. To access this new view, users can select an appropriate SQL Server instance, and then click Disk Size in the Views group of the
Resources tab. For more information on this feature, see Get disk size details.

Disk Space Usage report available in SQL Diagnostic Manager
The Disk Space Usage report provides users with the most recent snapshot of available disk space in their environment. To access this report,

users can go to Reports in the Navigation pane and select Resources > Disk Space Usage in the Analyze menu. For more information on this
report, see Disk Space Usage.

Disk Space History report available in SQL Diagnostic Manager

The Disk Space History report provides an overview on available disk space with an emphasis on the historic level of activity for a specific disk.
To access this report, users can go to Reports in the Navigation pane and select Resources > Disk Space History in the Analyze menu. For
more information, see Disk Space History.

Monitoring of additional SQL Server services

SQL Server Active Directory Helper Status

SQL Diagnostic Manager users are now able to monitor the status of the SQL Server Active Directory Helper service. For more information on
this new alert, see SQL Server Active Directory Helper Service Status alert.

SQL Server Browser Service Status

SQL Diagnostic Manager users are now able to monitor the status of the SQL Server Browser service. For more information on this new alert, see
SQL Server Browser Service Status alert.
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Server Summary report supports new SQL Server monitored services

The Server Summary report now also displays the current status of the SQL Server Active Directory Helper service and the SQL Server Browser
service. For additional information, see Server Summary.

9.1 Fixed issues

Installation

® This release fixes a Windows 7 compatibility mode issue that prevented users from installing SQL Diagnostic Manager past the selection
of a SQL Server instance to use for the Repository Database. An upgrade to InstallShield solved this issue.

Web console

® An issue preventing the SQL Diagnostic Manager web console from displaying, no longer occurs with the full integration to the IDERA
Dashboard.

Query views

® Anissue in the Query views of the single instance dashboard, causing data to populate slowly and timeout messages, no longer occurs.

Query waits view

® An arithmetic overflow error causing the Query Waits view of the SQL Diagnostic Manager Management console to display an empty
pane, no longer occurs.

Alerts

® This release fixes an issue that caused fragmentation alerts to trigger without updating the latest value returned in the Databases >
Table & Indexes view, resulting in false alerts.

® An issue preventing users from receiving critical Database Full (Percent) alerts no longer occurs.

® This release fixes an issue where SQL Diagnostic Manager triggered a false unable to monitor SQL Server status alert when an invalid
or nonexistent SPID was found during collection.

® This release fixes an issue where SQL Diagnostic Manager triggered false critical Database Full (Percent) alerts for several servers
when the actual values were much lower and did not require an alert notification.

Maintenance mode

® This release fixes an issue in the SQL Diagnostic Manager web console, where servers displayed incorrectly as in maintenance mode
even when maintenance mode was not enabled or scheduled.

SCOM Management pack

® An issue in the SCOM Management pack, preventing users from discovering the SQL Diagnostic Manager Repository when it contained
unexpected NULL values, no longer occurs.

WMI

® Anissue causing RPC errors on servers with FQDN and the WMI collection method enabled, no longer occurs.

9.0 New features

Integration with the IDERA Dashboard
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SQL Diagnostic Manager 9.0 now integrates with the IDERA Dashboard, a common technology framework, designed to support the IDERA
product suite. Users are able to obtain an overview of the status of their SQL Servers and hosted databases all in a consolidated view and
navigate to individual product dashboards for details. The IDERA Dashboard provides a central set of services for managing users, product
registry, instance registry, aggregated alerts across IDERA applications, a central web server, and tags for grouping instances. For additional
information, see Navigate the IDERA Dashboard.

New advanced query views

SQL Diagnostic Manager 9.0 takes SQL Diagnostic Manager’s capabilities around query monitoring and diagnostics to the next level with a new
Main Query view along with two low-level views (Query Signature and Query Details views). Users are now able to explore query data in multiple
ways and easily get a handle of query performance in their environment. In SQL Diagnostic Manager 9.0 query monitoring is enabled by default
for SQL Server instances running SQL Server 2008+, and collection is performed through Extended Events which has minimum impact on your
SQL Server performance. Improved query monitoring allows for capturing of Query Execution Plans and provides graphical representations of
the same in the Plan Diagram of the Query Details view. In addition, you can view the actual XML, SQL Text, and referenced columns of a query
execution plan. For additional information, see View your SQL Server queries information.

Improved and integrated SQL Diagnostic Manager web console

SQL Diagnostic Manager 9.0 provides a fully functional web console that integrates seamlessly with the IDERA Dashboard (common technology
framework) and is easy to access from any connected browser. The SQL Diagnostic Manager web console provides the overall status of a SQL
Server environment to help diagnose any issues. Users can quickly view the status of a single instance or instance groups, view all active alerts
in their SQL Server environment and drill down for details, or select different sub-views to diagnose performance issues faster, and view top
values for selected metrics. In addition, users are able to access the new advanced query views (see above) only from the SQL Diagnostic
Manager web console and not from the SQL Diagnostic Manager desktop client console. For additional information, see Navigate the web
console dashboard.

Licensing and version upgrading —

Upgrade to SQL Diagnostic Manager 9.0

Customers upgrading from previous SQL Diagnostic Manager versions to SQL Diagnostic Manager 9.0 need a new license key or it is not
possible to continue with the upgrade process. Users can access the IDERA Customer Portal at the moment of upgrade from the license
management window in SQL Diagnostic Manager (Help > Manage Licenses) or directly at https://idera.secure.force.com. Information necessary
to generate a new license key is provided in the license management screen or the portal.

Help documentation —

SQL Diagnostic Manager Help (User Guide and Release Notes) is now wiki-hosted and available at wiki.idera.com > SQL Diagnostic Manager.

9.0 Fixed issues

Query Monitor

® An issue preventing users from enabling the Query Monitor in monitored SQL Server 2000 instances no longer occurs.

Queries

® Anissue in the Queries tab and corresponding Statement mode, Signature mode and query history views, causing queries exported into
Excel to truncate, no longer occurs.

Alerts

® This release fixes an issue that prevented users from knowing when Repository grooming had timed out. SQL Diagnostic Manager 9.0
includes a new alert SQLdm Repository Grooming Time out that notifies users when SQL Diagnostic Manager no longer deletes stored
metrics in the Repository at the set schedule. To configure this alert access the Alert Configuration window.
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Reports

® Anissue preventing users from running the Disk Details report of the Resources analysis reports no longer occurs.

8.6 New features

Full support for SQL Server Express instances

SQL Diagnostic Manager 8.6 fully supports monitoring of SQL Server Express instances. The following editions are supported: SQL Server 2005
Express, 2008, 2008 R2, 2012, and 2014.

Reporting on Query Wait Statistics

You can now run the Query Wait Statistics report to quickly analyze different wait type categories on your SQL Server and identify where your
biggest bottlenecks are occurring impacting your performance. For additional information about the new Query Waits Statistics report, see Query
Waits Statistics report.

Query Waits information is now extended to the Top Servers and Top
Databases reports

SQL Diagnostic Manager has extended Query Waits information to the Top Servers and Top Databases report, providing users insight into the
queries on your SQL Server instance that exceed a specific wait threshold. Users can now view information on Top Servers by wait time and Top
Databases by wait time. For additional information, see Top Servers and Top Databases.

New database alert for Availability Group Preferred Replica

SQL Diagnostic Manager triggers an Availability Group Preferred Replica whenever the primary role changes to a different replica and is
unavailable for a defined amount of time in minutes.

8.6 Fixed Issues

Upgrade

® Users upgrading from SQL Diagnostic Manager 8.5 to 8.6 may encounter a message (see image below) that requests closing the Java
framework application to proceed with the upgrade process. This framework is in use by the SQLdm WebUI Service of our web console
feature. Clicking Ignore allows the upgrade installation process to complete successfully. You can also stop the SQLdm WebUI Service
manually and click Retry to proceed with the Upgrade Wizard.

blocked URL

General

® This release fixes an issue where scheduled SQL Diagnostic Manager Repository grooming failed.
® This release fixes an issue that prevented data from being returned on a SQL 2012 instance when selecting the option Use Extended
Events (SQL2012 + only) in the Wait Monitoring tab of the Monitored SQL Server Properties window.

Views

® An issue causing Data File Spaced Used and Log File Space Used values in the Overview > Details view to vary from the real server
values no longer occurs.

® This release fixes an issue where the number of sessions displayed in the Sessions > Details view, after applying the Affecting
Tempdb only filter, does not match the number of sessions in the Databases >Tempdb Summary view.

® Anissue preventing disk drive statistics to return in the Disk view of the Resources tab no longer occurs.

® This release fixes an issue that caused the Query waits and Query History views to lag displaying data when the frequency of how often
the console refreshes data was modified in the Tools > Console Options window.
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® SQL Diagnostic Manager is designed to return the information that you want to view in the Signature Mode, Statement Mode, and Query
History views through filters. However, the filter Exclude Currently Running Queries that excludes data returned with null values is not
applicable to the Query History view and is now disabled by default.

Alerts

® An issue issue causing OS Disk Full (Percent) alerts to trigger for disk drives previously excluded from alerting in the Alert Filters tab of
the Advanced Configuration window no longer occurs.

® This release fixes an issue impeding the Deadlock Sessions report with detailed deadlock information to display when right-clicking
(Show Deadlock Details) or double-clicking over a deadlock alert in the Alerts view. Note that after upgrading to our latest version it is not
possible to view deadlock details for alerts generated in SQL Diagnostic Manager 8.5 since this issue prevented deadlock information
from being stored.

® This release fixes an issue impeding the Blocking Sessions report with detailed blocking and blocked sessions’ information to display
when right-clicking (Show Block Details) in the Alerts view, double-clicking over a Block report in the Blocking view, or clicking the Show
Block Details link in the Details section of the Alert view. Note that after upgrading to our latest version it is not possible to view block
details for alerts generated in SQL Diagnostic Manager 8.5 since this issue prevented block information from being stored.

® An issue impeding new custom counters to be added in the Administration tab is solved.

Console

® This release fixes an issue present after upgrading to SQL Diagnostic Manager 8.5 with custom counters that had customized
categories. This issue caused a .NET framework error and the SQL Diagnostic Manager Console to crash when clicking any monitored
server.

Dashboard

® An issue preventing the Lock Waits and Tempdb panels from displaying in a customized Dashboard view no longer occurs.

Reports

® An issue preventing the Top Queries report to deploy correctly into a Microsoft Reporting Services Server no longer occurs.
® This release fixes an issue where a custom report was deployed into the Microsoft Reporting Services Server instead of the selected
report in SQL Diagnostic Manager with a similar name.

8.5 New features

Full support for SQL Server 2014

SQL Diagnostic Manager 8.5 fully supports monitoring of SQL Server 2014 RTM. Users who implement the SQL Server 2014 In-Memory OLTP
Engine functionality should note that SQL Diagnostic Manager does not support this feature at the moment.

Hyper-V support

SQL Diagnostic Manager 8.5 has extended virtual support to Hyper-V, providing users insight into the performance of their virtual system more
effectively. Users can track and monitor Hyper-V specific performance metrics for a complete view of the virtualized server and the physical host.
For additional information, see How SQLdm works with a virtual environment.

Tech Preview of the new SQL Diagnostic Manager web console

In SQL Diagnostic Manager 8.5 rapidly and easily identify problems. The SQL Diagnostic Manager web console is designed to provide quick
access to the overall status of the SQL Server environment to help diagnose any issues.

® Quickly view status of a single instance or instance groups.

® Access from any connected browser. No SQL Diagnostic Manager Desktop Console required.

® Stand-alone web application with no need for IIS.

® Provide an easy to use web console to non-DBAs without giving access to entire management console so they can check on status of
their SQL Server environment.

To provide feedback on the Tech Preview of the SQL Diagnostic Manager web console, access the IDERA community forum.
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@ The SQLdm REST Service requires a service account that is a local administrator. If the service account provided during installation for
the SQL Diagnostic Manager services is not a local administrator, you need to manually change the service account in Windows
Service Control Manager.

Monitoring and alerting enhancements

Enhanced alert response usability

Ability to set up Alert Response that is triggered only after multiple user defined metric thresholds have been breached. For additional
information, see Configure automated responses to alerts.

Inclusion filters for Query monitors

Ability to do query monitoring on selected applications, databases, and SQL text. For additional information, see Configure advanced query
monitor options.

New filter in the Signature Mode and Statement Mode views

Ability to exclude data returned with null values through the Exclude Currently Running Queries filter in the Signature Mode and Statement
Mode views.

Improved Maintenance Mode flexibility

Additional monthly option for scheduling maintenance mode on monitored SQL server instances. For details, see Schedule Maintenance Mode.

Virtualization counters available for custom reports

Select both Hyper-V and VMware virtualization counters when creating a custom report. For additional information, see Select counter type and
counters.

Run one-click System Diagnostics

Ability to run system diagnostics and collect service and desktop client logs in the System Diagnostics window. See System Diagnostics for
details.

Deadlock victim details now available in the Deadlock Sessions Report

The Deadlock Sessions Report of the Sessions>Blocking view includes deadlock victim information by default. Users no longer have to
manually add this option through the Column Chooser dialog. For additional information see, Analyze blocked sessions.

Configuration option added to control WMI timeouts

Configure the WMI timeout value in SQL Diagnostic Manager when suitable. For instructions, see Configure OS metrics monitoring.

8.5 Fixed Issues

General

® An issue causing settings in the Monitored SQL Server Properties window to revert no longer occurs.
® This release fixes an issue in deadlock data collection that caused discrepancies in the UTCCollectionDateTime.
® An issue causing SQL Diagnostic Manager to display an error on the monitored SQL Server 2014 instance when expanding the
databases node, no longer occurs.
® Some users may experience Windows console crashes, applying the Microsoft update 2919355 solves this issue. For additional
information on this solution, see the Microsoft knowledge base articles:
© QOut of memory when you load some image resources in a Windows application.
© Platform update for Windows 7 SP1 and Windows Server 2008 R2 SP1.
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Alerts

® An issue preventing cluster failover alerts to be triggered no longer occurs in SQL Diagnostic Manager 8.5.
® An issue preventing SQL Diagnostic Manager to update statistics for some monitored SQL servers that triggered a persistent alert
‘Unable To Monitor’ no longer occurs in version 8.5.

Reports

® This release fixes an issue impeding the VM Statistics report to display correctly.

® An issue preventing users from exporting the Blocking Sessions report in XML no longer occurs.

® An issue preventing the CPU Statistics report to display correctly when being deployed to the Microsoft Reporting Services no longer
occurs.

8.0.1 New features

There are no new features in this release.

8.0.1 Fixed issues

General

® Users with large Repository databases no longer experience high CPU Usage by the sqlserv.exe process.
® An issue causing occasionally negative CPU Delta (ms) and Physical I/0O Delta values in the Details view of the SQL Diagnostic Manager
Sessions tab, when parallel usage of CPU is enabled, no longer occurs.

Management Service Log

® An issue causing exceptions in the SQLdm Management Service logs when removing an availability group or replica from Availability
Group Topology no longer occurs.
® The exceptions logged for ‘primary and foreign key duplication errors’ no longer occur.

AlwaysOn Availability Groups

® An issue causing deadlock errors after updates to the AlwaysOn Availability Group Topology tables in SQL Diagnostic Manager no
longer occurs.

Mobile

® Users who remain logged in the IDERA Newsfeed account and upgrade to SQL Diagnostic Manager 8.0.1 no longer experience console
crashes.

8.0 New features

SQL Diagnostic Manager now fully supports the AlwaysOn Availability Groups
feature of SQL Server 2012

SQL Diagnostic Manager 8.0 now allows DBAs to monitor their availability groups, availability replicas, and availability databases. Support for this
feature comes with:

® An Availability Group Statistics report that allows you view the historical health of your availability groups, availability replicas, and
availability databases.

® An Availability Group Topology report that allows you to view the current topology of your availability groups configuration.

® Monitoring of key metrics specific to the AlwaysOn Availability Groups feature.

® Queue Size and Transfer Rates charts.
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For additional information on SQL Diagnostic Manager and the AlwaysOn Availability Groups feature, see Monitor AlwaysOn Availability Groups.

SQL Diagnostic Manager now offers integration with Microsoft System Center
Operations Manager (SCOM)

SQL Diagnostic Manager 8.0 now includes the SQLdm Management Pack (SQLdm MP) to enhance the SQL Server monitoring capabilities of
Microsoft System Center Operations Manager (SCOM). Detailed alert and status information tracked by SQL Diagnostic Manager provides
SCOM with a wealth of knowledge not previously available including:

® Seamless integration between SQL Diagnostic Manager and the SCOM health model and console.

® More robust overview of your server health and performance through the addition of SQL Diagnostic Manager metrics to the current
SCOM ability to use availability to determine SQL Agent health.

® Detailed record of state changes and events that might impact the availability and performance of your server.

® |nstant access to the SQL Diagnostic Manager Console from SCOM, providing access to vital insights not readily available using SCOM
alone.

For additional information about using SQL Diagnostic Manager with System Center Operations Manager, see Integrate SQL Diagnostic
Manager with SCOM.

Change Log Summary report

The Change Log Summary report allows users to view a list of all actions and configuration changes performed in their SQL Diagnostic Manager
environment over a specified period of time. For additional information on this report, see Change Log Summary.

Improved collection of query and non-query activities

SQL Diagnostic Manager 8.0 now allows users to collect solely queries’ performance data through the Query Monitor tab in the Monitored SQL
Server Properties window. Configure collection of non-query activities such as deadlocks and autogrow events through an independent window,
the Activity Monitor tab.

Blocked Process report available in SQL Diagnostic Manager

SQL Diagnostic Manager users are now able to view the captured Blocked Process report directly in their SQL Diagnostic Manager Console. In
the Activity Monitor tab, users can configure the Blocked Process Threshold (in seconds) that results in the Blocking Process and Blocked
Process details report. To access this report, users can go to Sessions>Blocking and double click under Block Reports. For more information on
this feature, see Set activity monitor options.

Improved Maintenance Mode and Snooze Alerts features

In the SQL Diagnostic Manager 8.0 version, applying maintenance mode modifications to a large number of servers at once is possible through
the Maintenance Mode command. Review Schedule Maintenance Mode for details. Also users that want to tackle several alerts, can mass
snooze/resume alert generation through the Snooze Alerts/Resume Alerts commands. For additional information, see Snooze Alerts.

SQL Diagnostic Manager Console supports Operating Systems where FIPS
compliance is required

The SQL Diagnostic Manager 8.0 console supports operating systems with enabled system cryptography that use FIPS (Federal Information
Processing Standard) complaint algorithms. For more information about FIPS compliance, see the Microsoft document, FIPS Compliance.

SQL Server 2014 experimental support

SQL Diagnostic Manager 8.0 is SQL Server 2014 compatible. This version of SQL Diagnostic Manager is not certified against newer builds of
SQL Server and should not be used with these builds in a production environment. IDERA provides experimental support while you use your
installation in a testing environment to ensure the features you rely on most are working as or better than expected.

Users who implement the SQL Server 2014 In-Memory OLTP Engine functionality should note that SQL Diagnostic Manager does not support
this feature at the moment.

8.0 Fixed Issues
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General

® An arithmetic overflow error that converts expression to data type integer in the Query Waits and Session Details views no longer occurs.

® An issue causing errors related to data retention or data visibility in the History Browser no longer occurs. Note that some views in
SQL Diagnostic Manager only collect data on demand in the repository after configuration.

® |n SQL Diagnostic Manager 8.0 users are now able to limit the amount of memory used by the desktop client.

Servers

This release fixes an issue that occurred while refreshing the Server Summary view.

Databases

An issue causing errors related to fragmentation collector timeouts or fragmentation statistics collection in the Tables & Indexes view no longer
occurs.

Services

This release fixes an issue caused when the collector for the SQL Agent Jobs View could not interpret null values, resulting in job and job steps
collection errors.

Alerts

® The transactions (Per Second) metric now displays correctly in the History Browser when user selects a historical snapshot.
® This release fixes an issue where after modifying the advanced configuration settings of the SQL Server Status alert, the Lowered to OK
status still showed.

Resources

An issue causing an unknown value in the User/Schema column of the Procedure Cache view no longer occurs.

Reports

An issue preventing users from running the Alert History Report after deployment to Reporting Services no longer occurs.

7.5.4 New Features

General

Charts now properly manage real-time and scheduled collection data in the same time
span

SQL Diagnostic Manager charts provide data whether collected real time or as part of a scheduled collection event. If you pause or leave this
view and then return during the same Console session, SQL Diagnostic Manager displays the real-time data points as previously viewed,
followed by a period of data points from any scheduled collections that occurred while you were away. For additional information about how
SQL Diagnostic Manager displays charts, see Charts.

Queries

Query Waits now located on Queries tab

The Query Waits feature is no longer located on the Resources tab but now is available on the Queries tab. For additional information about
Query Waits, see View Query Waits.

Alerts
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Manage how the SQL Diagnostic Manager Console responds to alert notifications

SQL Diagnostic Manager can now play a sound when an event triggers an alert to change states. You can also control how SQL Diagnostic
Manager displays the resulting alert notification in the Console. For additional information about Console notifications for alerts, see Configure
notification settings.

Set SQL Diagnostic Manager to notify you of only critical alerts

Use the Notifications section of the Console Options feature to set SQL Diagnostic Manager to notify you for only critical alerts. You can select
whether you want to view or even play a sound when a critical alert occurs. For additional information about Console notifications for alerts, see C
onfigure notification settings.

Mobile

SQLdm Mobile & IDERA Newsfeed now supports 1IS 8

SQLdm Mobile & IDERA Newsfeed now supports IIS 8 on Windows 2012 and Windows 8 environments. For additional information about SQLdm
Mobile & IDERA Newsfeed requirements, see SQLDM Mobile and IDERA Newsfeed requirements.

7.5.4 Fixed Issues

General

® SQL Diagnostic Manager now responds to the collection filtering set for disk drives to prevent the Collection service from gathering data
on non-monitored disks.

® Users who upgraded to SQL Diagnostic Manager 7.5.3, and who collect data using a direct WMI connection no longer experience an
issue causing an instance to stop collecting snapshots.

® An issue causing errors when the Collection service attempted to collect Table Growth information no longer occurs.

Servers

® SQL Diagnostic Manager no longer pauses data point creation in other real-time panels when the user accesses the Timeline view.

® This release fixes an issue caused when the scheduled refresh did not successfully complete, resulting in missing History Browser
snapshots.

® The SQL Server Plan Cache object no longer continues to grow with SQL Diagnostic Manager queries even with the SQL Server
Optimize for ad hoc workloads server configuration option selected.

® The SQL Diagnostic Manager Powershell plug-in now properly puts monitored SQL Server instances into maintenance mode when
selected.

Alerts

® The Autogrow alert no longer displays the same previous and current data file size when viewing alert details in the Alerts view.

® SQL Diagnostic Manager no longer dismisses certain alerts when SQL Diagnostic Manager generates an Unable to Connect, Unable to
Monitor, or Paused alerts. These alerts include SQL Server Agent job alerts, VM Host Server Change, VM Resource Configuration
Change, Mirroring Server Role Change, and Cluster Failover alerts.

® SQL Diagnostic Manager no longer displays an incorrect percentage in the Database Full (Percent) alert.

® SQL Diagnostic Manager no longer delays generation of some Oldest Open Transaction alerts until the transaction is significantly older
than the alert threshold. The alert now triggers immediately when the transaction crosses the threshold.

® An issue preventing some users from monitoring multiple instances and causing job completion error alerts no longer occurs.

Reports

® The Server Summary report now correctly displays statistics graphs and grids even when the results include no data for that interval.
® The Server Statistics report now consistently applies the UTC offset to both servers when using the report to compare two servers.

Counters/Custom Counters
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®* When WMI counters are unavailable due to a stall, SQL Diagnostic Manager now continues to collect available counter data until it hits
the connection limit and triggers an alert.

® VM custom counters now close the connection to the vCenter Server immediately after use, thereby avoiding a high number of
connections to the server at one time.

7.5.3 New Features

There are no new features for SQL Diagnostic Manager 7.5.3.

7.5.3 Fixed Issues

General

® Users who upgrade to SQL Diagnostic Manager 7.5.2 no longer experience missed alerts.

® Users who upgrade from SQL Diagnostic Manager 6.2 to a more recent version of SQL Diagnostic Manager no longer experience issues
upon subsequent upgrades. SQL Diagnostic Manager displayed the message, "Query Monitor upgrade paused,” in the log and caused
excessive connections to the Repository.

® Users with large databases who upgrade to SQL Diagnostic Manager 7.5.2 no longer experience Management Service blockage,
causing slow inserts into the Repository.

® SQL Diagnostic Manager now successfully installs and no longer stalls on the splash screen while displaying the message, "Connecting
to Repository."

® The SQLdm Management Service no longer causes high CPU on the Repository.

7.5.2 New Features

There are no new features for SQL Diagnostic Manager 7.5.2.

7.5.2 Fixed Issues

General

® When upgrading to SQL Diagnostic Manager 7.5.x and a timeout occurs while upgrading the database statistics, SQL Diagnostic
Manager now properly re-submits the query and no longer indicates that it is running without re-starting the stopped upgrade. This issue
caused some users to not see older database information.

® An issue causing the SQL Diagnostic Manager Console to take a long time to load or time out after upgrading to 7.5 and display the
message, "Unable to connect: Timeout expired attempting to open server connection," no longer occurs.

® Users who upgrade to SQL Diagnostic Manager 7.5 no longer experience an issue causing the transaction log file to grow dramatically.

® An issue with the stored procedure p_GetTagServersAsXML not closing or de-allocating a cursor no longer occurs as the stored
procedure no longer uses a cursor.

® An issue with table statistics collection causing a communication problem between the Management Service and the Collection Service
is resolved.

® SQLdm no longer displays an "Arithmetic overflow error" message when refreshing the Server Summary view This issue was caused by
a timestamp containing a value greater than the SQL Server Max Integer value.

Overview

® An issue causing SQL Diagnostic Manager to display some monitored SQL Server instances more than once in the Servers tree no
longer occurs.
®* The CPU Dashboard panel no longer displays an occasional red "X" in the Call Rates chart when the panel is resized.

Sessions

® SQL Diagnostic Manager no longer displays the messages, "Error executing Session List collector: Arithmetic overflow error converting
expression to data type int," or "Error processing Session List Collector: Object reference not set to an instance of an object,” when
some users attempt to access pages in the Sessions view.
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Resources

® SQL Diagnostic Manager no longer displays the error message, "The given key was not present in the dictionary,” when a user attempts
to view Server Waits.

Alerts

® SQL Diagnostic Manager custom counters now properly trigger alert responses.
® Deadlock and Autogrow alerts no longer persist after the triggering condition is resolved.

Reports

® SQL Diagnostic Manager no longer displays the message, "ltem with the same key has already been added," when some users attempt
to run the Top tables by Growth or Top Tables by Fragmentation report.
® Users can now select the time of day in all SQL Diagnostic Manager reports by using the Start Hours and End Hours fields.

7.5.1 New Features

There are no new features for SQL Diagnostic Manager 7.5.1.

7.5.1 Fixed Issues

General

® An issue causing an exception error and possibly preventing some users from closing the SQLdm desktop client no longer occurs.

Overview

®* The Memory, Network, and Virtualization panel chart selections are now properly saved when a user saves a Dashboard layout.
® Timeline users who double-click an alert to access the Alerts pane with the selected alert highlighted now receive the proper selected
alert information in the Details pane of that view.

Sessions

® On a case-sensitive server, the Sessions Blocking graph now shows the correct deadlocks in the sessions.

Resources

® The Query Waits graphs right-click menu options View Text and View Query History are now operative.

Logs

® A user interface update fixed an issue causing some Microsoft Windows 7 users to see a cut-off Search window in the Log tab.

Alerts

® SQL Diagnostic Manager and the Windows Event Log now both show accurate metrics for the OS Disk Free Space (Size) alert.
Reports

® Users who attempt to schedule email notifications for some reports no longer receive an error message at the end of the wizard.
® Generation of the Top Databases report is improved, preventing the report from suffering a time out because of the long load time.
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® Disk Details report users no longer receive an exception message when attempting to run the report with the Drive Name field selection
of All Drives.

7.5 New Features

There are no new features for SQL Diagnostic Manager 7.5.

7.5 Fixed Issues

General

® The SQL Diagnostic Manager installer no longer checks your Windows firewall service. If you have communication issues after
installation, verify that ports 5166 and 5167 are open for access in Windows firewall and/or whichever firewall you use.

® SQL Diagnostic Manager now properly aggregates data based on the number of days displayed in the Aggregate query data into daily
records after X days field in the Grooming Options.

® Users monitoring disk activity on Windows 2008 and later operating systems no longer have to wait one second per disk for statistics
gathering.

® Users no longer receive false "Unable to connect" alerts for monitored SQL Server instances known to be online. The server availability
check now attempts one connection retry in order to avoid alerting in case of transient network issues.

® SQL Diagnostic Manager now can send email notifications to Gmail accounts and other email accounts using SSL encryption.

® The About IDERA SQL Diagnostic Manager dialog box no longer includes the System Info button.

Virtual Machines

® An issue in the SQLdm Management Service causing some VM statistics to not display for monitored virtual SQL Server instances no
longer occurs.

Dashboard

® An issue causing the CPU Dashboard panel to display O when a greater value should appear no longer occurs. This issue was caused
by SQL Diagnostic Manager switching from one counter to another at certain refresh rates when calculating CPU values.

Server Overview

® SQL Diagnostic Manager no longer attempts to delete a monitored SQL Server instance in some situations when the user pressed the
Delete key while in the Server view.

® An issue causing some users to receive an exception error when attempting to view Server Details after quickly clicking through different
panes of the SQL Diagnostic Manager Management Console no longer occurs.

Sessions

® The Y-axis unit of time measurement now appears in the Sessions > Locks Wait Time chart as "ms" (milliseconds).

Resources

® Resources > Query Waits times are now in chronological order.
® Users no longer receive the error message, "The given key was not present in the dictionary," when attempting to view the Resources >
Server Waits view.

Databases

® SQL Diagnostic Manager no longer displays restore activity on the original database instead of the destination database. Now the
destination database includes any restore information.

Services
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®* The SQL Agent Jobs list now retains the open (+) and closed (-) settings after a refresh. This list also remains on the same row after a
refresh and no longer jumps to the top of the list.

® An issue causing the job collector to fail for some users no longer occurs. This issue occurred when the user attempted to filter jobs or
job categories with a string that included a single quote character (') in the title.

Alerts

® The Alerts pane now retains your column sort selection when you return to the pane after visiting another page, as when investigating an
individual alert.

® SQL Diagnostic Manager now sends an alert when a cluster failover occurs even when the server appears as offline in the preceding
refresh of the SQLdm Collection Service. Previously, this situation would not trigger a cluster failover alert.

® The Session Tempdb Space Usage (MB) alert now triggers based on the Total User Space Used and no longer includes the Total

Internal Space Used in the calculation. This update fixes an issue where users received an alert that shows a tempdb session using

more space than the entire size of tempdb.

The Cluster Failover alert no longer displays a timestamp of 1-1-1900 when an event triggers an alert.

The Unsubscribed Transactions alert now displays the resulting time in hours, minutes, and seconds for easier comprehension.

This release fixes an issue that caused some users to receive alerts stating that the data files are over 1000.00% full.

Users no longer receive multiple email messages for the same alert.

Reports

® Users no longer receive the error message, "An error occurred while retrieving data for this report. Additional information: Invalid Column
name. (Microsoft SQL Server, Error: 207)," when attempting to run a custom report.

® An issue causing the Top Queries report to appear empty when the user selected a Custom Range older than seven days no longer
occurs.

Custom Counters

® An issue causing some users to receive an error message when attempting to modify an existing custom counter no longer occurs.

7.2.2 New Features

There are no new features for SQL Diagnostic Manager 7.2.2.

7.2.2 Fixed Issues

® SQL Diagnostic Manager 7.2.2 now displays an accurate Physical I/0O metric on the Blocking view of the Session tab.

® SQL Diagnostic Manager 7.2.2 no longer displays XML document related error messages to users who upgrade to SQL Diagnostic
Manager 7.2 with a SQL 2005 repository. To learn more about the cause of this issue, see Microsoft Support Article 968914, "FIX: When
you convert a TEXT column to a VARCHAR(MAX) column, an NTEXT column to a NVARCHAR(MAX) column, or an IMAGE column to a
VARBINARY(MAX) column, the original NULL values in these columns may become empty strings in SQL Server 2005."

® An issue causing some users to receive an error message when attempting to view details for a monitored SQL Server instance no
longer occurs. When this issue occurred, the results were replaced by a large red X.

® Both the Alerts and Custom Area views in SQLdm Mobile now display your custom counters regardless of whether you defined unique
category hames. By default, SQL Diagnostic Manager assigns the category “Custom” to all custom counters.

7.2.1 New Features

SQL Server 2012 RTM Support

SQL Diagnostic Manager 7.2.1 supports the use of SQL Server 2012 RTM version. Users who implement the SQL Server 2012 AlwaysOn
functionality should note that while SQL Diagnostic Manager seamlessly monitors servers with this feature enabled, it does not currently
administer or diagnose issues with AlwaysOn.

7.2.1 Fixed Issues
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® Users who have implemented SQL Diagnostic Manager 7.2 with SQL Server 2012 RCO in a non-production environment may
experience issues with data display on the Tempdb Summary and Database Files views after upgrading to SQL Diagnostic Manager
7.2.1. Upgrading to SQL Server 2012 RTM their test environment will remedy this issue.

® SQL Diagnostic Manager 7.2.1 no longer displays error messages related to an "XML document" when users who upgraded to SQLdm
7.2 attempt to access the SQLdm Management Console.

® Users who implemented SQL Diagnostic Manager 7.2 with SQL Server 2012 RCO in a non-production environment now receive an
accurate name and version number for SQL Server 2012 RTM when viewing the Compatibility Level for a monitored SQL Server 2012
RTM instance.

7.2 New Features

Monitoring SQL Server virtual environments

Get complete insight into the performance of your virtualized SQL Server databases. Monitor and track VMware-specific performance
counters allowing you to get a complete performance picture of the SQL Server environment. Two VM-related reports provide performance
trends and a summary of your virtualized environment. For additional information about configuring the new VM functionality, see Configure
your virtual machine connections.

SQL Server 2012 experimental support

SQL Diagnostic Manager 7.2 is SQL Server 2012 RCO compatible. This version of SQL Diagnostic Manager is not certified against newer
builds of SQL Server and should not be used with these builds in a production environment. IDERA provides experimental support while
you use your installation in a testing environment to ensure the features you rely on most are working as or better than expected.

Users who implement the SQL Server 2012 AlwaysOn functionality should note that while SQL Diagnostic Manager seamlessly monitors
servers with this feature enabled, it does not currently administer or diagnose issues with AlwaysOn. For additional information about
SQL Diagnostic Manager and SQL Server 2012, see SQL Diagnostic Manager requirements.

SQLdm Mobile views

SQLdm Mobile features a new server dashboard specifically for tablets and incorporated VMware monitoring data. For additional
information about the new SQLdm Mobile features, see SQLdm Mobile Help.

Reporting on Tempdb Statistics

You can now run the Tempdb Statistics report to quickly identify and keep tabs on tempdb performance-related issues. For additional
information about the new tempdb report, see Tempdb Statistics report.

SQL Server Memory Usage Percent counter available for custom reports

You can now select the SQL Server Memory Usage Percent counter when creating a custom report. For additional information about
creating a custom report, see Custom reports.

Updated alert notification functionality

SQL Diagnostic Manager now allows you to suppress system tray notifications when a monitored SQL Server instance returns to an OK
status. Click Tools > Console Options. On the Notifications tab, check the Never show console alert notifications when the server status
goes to OK checkbox, and then click OK. For additional information about the Management Console options, see Configure Console
Options.

CPU Statistics report now available in a custom range of hours

The CPU Statistics report now includes an option for you to select a custom date range and view results in hours. To select this range,
click Reports > CPU Statistics. Select the appropriate monitored SQL Server instance, and then select Custom Range from the Period
drop-down list. Use the calendar tool to select the range, and then click OK. Select Hours from the Sample drop-down list to view your
results in hours. For additional information about the CPU Statistics report, see CPU Statistics report.
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Input how long SQL Diagnostic Manager waits before raising an alert for along-
running job

Users can now specify a minimum job length for the SQL Server Agent Long Running Job (Percent) alert. This may be used to prevent
alerting on short or trivial jobs. For additional information about configuring job exclusions, see Configure Job Exclusions.

7.2 Fixed Issues

® Users with a large number of databases no longer notice a performance issue caused by leaving the SQL Diagnostic Manager
Dashboard open for a long period of time.

® The Value Configuration window in SQL Diagnostic Manager no longer displays blank column headings but includes alert state icons to
easily identify the content. You can access the Value Configuration window by clicking Edit on the Alert Configuration window.

® The Login Time column of the Sessions Details page now uses the local time on the client server for the timestamp. You can access the
Sessions Details page by clicking Sessions > Details while viewing a monitored SQL Server instance.

® SQL Diagnostic Manager no longer displays an error message when a user attempts to view tempdb detail for a SQL Server 2000
monitored instance. Tempdb monitoring is supported for SQL Server 2005 and above monitored instances only.

® Table growth collection no longer fails for monitored SQL Server 2000 servers, allowing the Top Table Growth report to function correctly.

® SQL Diagnostic Manager no longer displays an error message when a user attempts to use PowerShell cmdlets to configure Query
Monitor.

®* The CLR Enabled alert now properly functions after triggering an Informational alert.

® The Export to Excel function on the Tempdb Sessions view no longer fails for users who had cells in the Last Command column
containing more that 32,767 characters.

® The Database Statistics report results format is updated and no longer causes any issues in viewing accurate results for users with large
databases.

® SQL Diagnostic Manager no longer displays and error message when a user attempts to schedule an email delivery of the Top Tables
by Fragmentation report.

® The Repository now properly saves Query Monitor data while the grooming job runs.

® A failure in the SQL Diagnostic Manager replication monitoring no longer prevents otherwise successful scheduled refreshes from saving
to the repository.

®* The Table Fragmentation (Percent) alert now changes to gray shading if the alert is raised for more than 12 hours.

® Extremely long queries no longer cause the Query Monitor to generate OutOfMemory exceptions on the Collection Service. These
exceptions could previously cause a service crash.

® Users no longer experience an error during installation that caused an error when attempting to validate the user account used to
perform the install.

* Performance updates including query aggregation and grooming changes improve SQL Diagnostic Manager data collection and
processing efficiency.

® SQL Server authentication no longer occasionally fails for users attempting to use a password containing the quotation mark () special
character.

®* When you delete a database, the system is groomed to removes all references to that database. Now the feature also grooms the
deleted database from the [SQLServerDatabaseNames] table.

7.1.1 New Features

There are no new features for SQL Diagnostic Manager 7.1.1.

7.1.1 Fixed Issues

® Improvements now allow SQL Diagnostic Manager to return data for the Session Details page more quickly and avoid a timeout due to
slow or no response.

7.1 New Features

New SQL Server dashboard

SQL Diagnostic Manager now features a completely redesigned dashboard, which dramatically expands the display of your performance
data and simplifies the view of the overall health of a SQL Server instance. For additional information about the new dashboard, see the SQ
L Server performance overview.
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New Tempdb monitoring

You can now quickly identify and resolve tempdb performance-related issues with the new tempdb monitoring and diagnostic views. For
additional information about the new tempdb monitoring functionality, see tempdb status summary.

New SQLdm Mobile views

The following new views in SQLdm Mobile make diagnosing performance issues even easier while you're on the go:

© Blocking Chain View
© Sessions > Top Wait Customer View
© Tempdb Monitoring View

For additional information about SQLdm Mobile, see SQLdm Mobile Help.

View and copy SQL Agent Job messages from the Job History list

SQL Diagnostic Manager now allows users to view SQL Agent Job messages from the Job History list. Right-click the appropriate job, and
then select View Message. A copy feature allows you to copy the existing message and then paste it into a different application. For more
information about SQL Agent jobs, see how to Monitor SQL Agent Jobs.

7.1 Fixed Issues

® SQL Diagnostic Manager Repository timeouts no longer cause the SQL Diagnostic Manager services to stop for some users.

® This release of SQL Diagnostic Manager fixes an issue that caused SQL Diagnostic Manager to display an error message when some
users attempted to configure alerts.

® SQL Diagnostic Manager performance improvements decrease the amount of time spent waiting for page loading and processes to

complete.

The CLR Enabled alert now properly retains settings when the user changes the alert state to Informational.

SQL Diagnostic Manager no longer experiences an issue when a user adds servers to a custom view.

Improved collection functionality corrects an issue causing some users to see an incorrect SQL CPU Usage statistic.

Refreshing the SQL Agent Jobs view no longer deselects all selected rows.

The SQLdm Service Availability chart on the Services tab no longer incorrectly displays, "Unable to monitor" when the server is available.

SQL Diagnostic Manager no longer displays an error message when users who upgrade to SQL Diagnostic Manager 7.0 attempt to edit

their custom counters.

® SQL Diagnostic Manager no longer displays the error message, "An INSERT EXEC statement cannot be nested," for some users who
attempt to run a report when SQLdm Application Security is enabled.

® SQL Diagnostic Manager users monitoring SQL Server instances by IP address instead of name no longer receive the error message,
"The server you are trying to access is not monitored by IDERA SQL Diagnostic Manager," when attempting to view history for a
mirrored database.

® Users who have clustered servers no longer receive the error message, "Error interpreting Services Collector: Invalid length parameter
passed to the substring function" when attempting to use the Show Real Time View function.

7.0 New Features

New SQLdm Mobile interface

SQL Diagnostic Manager now offers a Web application (SQLdm Mobile) that displays real-time SQL Server performance dashboards on a
variety of mobile devices, including iPhone, iPad, Android and Blackberry. SQLdm Mobile includes the IDERA Newsfeed technology. The

IDERA Newsfeed is a revolutionary new way for DBAs and managers to collaborate, share knowledge, and keep close tabs on their most

critical SQL Server issues.

New Alert Templates
SQL Diagnostic Manager now offers alert templates, which allow a user to configure generic alert settings to apply to monitored SQL

Servers or groups of servers all at once. You can create and assign alert templates to any of your monitored SQL server instances.

New Informational Alerts
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Informational alerts allow you to set a threshold that triggers a status that does not affect the overall status of the server within SQL
Diagnostic Manager. You can use informational alerts to notify an administrator of the state of a particular metric for a server or trigger
secondary processes that could take action to prevent issue escalation.

Improved Alert Response Usability

Alert Response rules, which configure how SQL Diagnostic Manager responds when an event triggers an alert, are easier to create and
manage due to an updated interface and process. Users can now apply an alert response rule to all metrics quickly and easily.

Improved Notification Times for Unresponsive SQL Server Instances

SQL Diagnostic Manager can now alert you more quickly when one of your monitored SQL Server instances becomes unresponsive for
any reason. Although the default is set to 30 seconds, you can adjust the interval at which the Collection Service checks whether your SQL
Server instances are “up” or available. If a connection is not confirmed within the specified time, SQL Diagnostic Manager creates an
Unable to Connect alert.

Improved Metrics Collection

The Collection Service now:

O Uses a different SQL Server metric to determine the CPU Busy Value for instances running SQL Server 2005 or later. This
change prevents timeout errors during the metric collection process.

© Uses separate processes to collect table growth and fragmentation metrics. This approach ensures quiet time data collection
does not delay alerts about other metric thresholds.

© |s able to efficiently collect error log metrics for SQL logs that are large or infrequently cycled.

Improved Repository Performance

The SQL Diagnostic Manager Repository database will perform more efficiently due to the following enhancements:

© The Repository grooming job now:
® Calls the index maintenance in a separate step. Using SQL Server Management Studio, you can now disable this step
and then later run your own index maintenance script after the grooming job completes.
= Better handles I/0 and CPU demands when processing data.
© Several stored procedures used by SQL Diagnostic Manager Repository were updated.

New Reports

SQL Diagnostic Manager now offers the following new reports:

© The Metric Thresholds report is for users who want to view a list of metric thresholds for a monitored SQL Server instance. The
report includes the metric name, description, and threshold for their informational, warning, and critical alerts.

© The Disk Details report lists key disk metrics for a specific SQL Server instance. This report offers Disk Time Per Read, Disk
time Per Transfer, Disk Time Per Write, Disk Reads Per Second, Disk Transfers Per Second, and Disk Writes Per Second.

7.0 Fixed Issues

Alerting Updates

SQL Diagnostic Manager now offers the following updates to alerting:

© SQL Diagnostic Manager now accesses the correct database when a user double-clicks an associated Fragmentation alert on
the Active Alerts tab of the SQLdm Today page. When you use this feature, SQL Diagnostic Manager displays the affected
database information on the Tables & Indexes pane of the Databases tab.

© Editing an alert response no longer causes SQL Diagnostic Manager to display an error message when attempting to save your
changes. This issue affected users who manually changed XML detail in the repository, and then attempted to save additional
alert response changes using the SQL Diagnostic Manager Console.

© SQL Diagnostic Manager now properly captures customer error detail when Error: 0, Severity: 19, State: 0 occurs. This issue
affected users using the SQL Server error log alert.

© The SQL Diagnostic Manager scheduled alert refresh is no longer dependent on table statistics before completing a full refresh
and possibly triggering alerts. Because table growth and fragmentation can be long-running processes, SQL Diagnostic
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Manager was delayed in delivering alerts. These items were removed from the scheduled alert refresh for a more responsive
alert system.

SQL Diagnostic Manager now raises an alert when a monitored SQL Server instance does not respond within the default 30
seconds. You can configure the response time in the Server Properties.

SQL Diagnostic Manager now checks to make sure that the WMI services are running before trying to connect to a monitored
SQL Server instance. If SQL Diagnostic Manager detects that previous attempts to connect are causing multiple connections, it
will stop monitoring that server and triggers an alert. All real time views in SQL Diagnostic Manager will display an error
message explaining the issue. SQL Diagnostic Manager automatically resumes monitoring once the number of connections
drops below the default of 30 connections.

Fragmentation Monitoring Updates

SQLdm now offers the following updates to your table fragmentation monitoring:

o

o

SQLdm now accurately collects table fragmentation data on tables within the entered size range. An issue causing SQLdm to
collect table fragmentation data on tables less than the entered minimum size no longer occurs.

Large tables no longer cause a block when collecting table fragmentation on a monitored SQL Server instance. This issue
occurred when multiple very large tables were involved. Fragmentation data for populating the reorganization panel on all tables
in a database is not collected. The reorganization query in SQLdm 6.1 and SQLdm 6.2 can timeout before table statistics are
collected. For more information, refer to IDERA Solution 1583.

SQL Server Statistics Updates

SQL Diagnostic Manager now offers the following updates to the functionality that collects and analyzes your SQL Server statistics:

o

The Sessions view now retains any custom filtering when viewing your Historical Snapshots. Custom filtering across all
snapshots helps you quickly determine changes needing your attention.

The History Browser on the Queries tab now allows you to scroll when you have large amounts of data.

The SQL Server Physical I/0 chart on the Resources tab now displays values in seconds instead of raw values. Displaying
results in seconds provides you with more accurate real-time analysis.

Users with mirrored databases no longer receive an error message that the mirror is not monitored when the database is
actually monitored. This issue affected users viewing their monitored mirrored database information in the real time view on the
Mirroring pane of the Databases tab.

SQL Diagnostic Manager now includes a new counter for collecting CPU stats. This new counter include a number of
improvements over the previous counter, which occasionally suffered an error due to reaching maximum capacity cumulative
CPU time.

SQL Diagnostic Manager no longer displays an error message when a user stops the Session Detail Trace and then refreshes
the view. Previously, users received the error message, "Error starting Session Details collector System.
InvalidOperationException: BeginExecuteReader: CommandText property has not been initialized."

Users with very large numbers of tables no longer cause the CPU to reach maximum threshold during table statistics collection.
New processes allow SQL Diagnostic Manager to read large data sets in smaller chunks to avoid collecting unnecessary data
and causing a strain on CPU resources.

Users working on diagnostics while troubleshooting can now add a configuration file entry to limit the procedure cache row
count. The new key is maxRowCountProcedureCache, which has a default value of 10000.

This release includes improvements to the repository grooming process, which fixes grooming of the ServerActivity table and
resolves an issue causing occasional deadlocks during grooming.

Reporting Updates

SQL Diagnostic Manager now offers the following updates to reporting:

o

Unauthorized users can no longer access data for restricted SQL Server instances when viewing a report through SQL Server
Reporting Services. This issue affected all users who restrict access to specific instances using Application Security features.
This update improves data security and prevents confusion when a user unwittingly views data for the wrong instance.

Users can now select up to 10 Windows, SQL Server, and/or custom counters when creating a custom report. These additional
counters provide more flexibility and detail in your reports.

If a custom counter contains special characters (<>%-), then your custom report generation fails with the error: Field names
must be CLS-compliant identifiers. A CLS-compliant Custom Counter name uses the following rule: the first character of an
identifier can be an uppercase or lowercase, titlecase, modifier, or other letter, or letter number. The subsequent characters can
be any of the previously-mentioned characters, plus non-spacing or spacing combining marks, decimal numbers, connector
punctuation, and formatting codes.
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